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Zusatzinformationen
zum DSM-26LAN und DSM-48LAN

Im Folgenden finden Sie wichtige Informationen zu den
Zugriffsebenen, Zugriffsrechten und Passwortern fir die
Gerate. Weiterhin ist die Bedienung des Steuerprogramms
kurz beschrieben. Diese Anleitung richtet sich an den Installa-
teur der Audio-Anlage. Bitte lesen Sie die Informationen vor
dem Betrieb gruindlich durch und heben Sie sie fir ein spéate-
res Nachlesen auf.
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Additional Information
for DSM-26LAN and DSM-48LAN

These instructions provide important information concerning
access levels, access rights and passwords for the units. In
addition, the operation of the control program is briefly
described. These instructions are intended for the installers of
the audio system. Please read these instructions carefully
prior to operation and keep them for later reference.
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1 Zugriffsebenen

Sollten sich nicht alle in der Anleitung
beschriebenen Bedienvorgange durchfih-
ren lassen, sind moglicherweise einge-
schrénkte Zugriffsrechte die Ursache.

Fir die Konfiguration des Gerats stehen
vier Zugriffsebenen mit unterschiedlichen
Rechten zur Verfligung. Der Zugang zu
den Ebenen wird Uber unterschiedliche
Passwérter erreicht. Die Passwortelngabe
erfolgt am Gerat (Menupunkt A
Lawsli Enter Fassword) oder uber
das Steuerprogramm (MenUpunkt ,Hard-
ware # Enter Password, 1= Kap. 2.3.7.1).

Die folgende Tabelle zeigt die Zugriffsebe-
nen in absteigender Rangfolge und die
zugehdrigen Passworter.

Zugriffsebene Passwort*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State -

(5) Passwortvorgaben

*Diese Passworter sind vom Werk vorgegeben und
kénnen vom Anwender in der jeweiligen Zugriffs-
ebene oder einer héheren Ebene gedndert wer-
den. — Geanderte Passworter gut merken!

Die Passworter sind im Gerat gespeichert.
Nach dem Einschalten ist das Geréat nor-
malerweise in der Ebene ,User“. Nach der
Eingabe eines Passwortes befindet sich
das Geréat dann in der entsprechenden
Zugriffsebene, bis es ausgeschaltet wird,
ein anderes Passwort eingegeben wird
oder in den ,Locked State“ gewechselt
wird. Der ,Locked State“ kann am Geréat
Uber den Menlpunkt Hooess  Lewsll
Locksd oder im Steuerprogramm  Uber
den MenUpunkt ,Hardware #Lock Unit*
erreicht werden.

Es kénnen in einer héheren Ebene
jeweils die Bedienmdglichkeiten der niedri-
geren Ebenen eingeschrénkt werden. Dies
ist jedoch nur Uber das Steuerprogramm
maoglich (i Kap. 2.3.7.3).

2 Das Steuerprogramm

2.1 Installation der PC-Software

Systemvoraussetzung fir die Installation
des mitgelieferten Steuerprogramms ist ein
Computer mit dem Betriebssystem Wind-
ows XP mit Service Pack 2 oder einer
héheren Windows-Version oder Mac OS X
ab Version 10.5.8 und einer Ethernet-
Schnittstelle oder einer USB-Schnittstelle.
Die Bildschirmauflésung sollte mindestens
1024 x 768 Bildpunkte betragen. Fur die
Installation der PC-Software das Installati-
onsprogramm ,Setup.exe” oder ,Setup [...]
.msi“ bzw. ,[...] Controller.mpkg® (fiir Mac
OS X) auf der mitgelieferten CD starten und
den Anweisungen des Installationspro-
gramms folgen.

Wird das Gerat Uber die USB-Schnitt-
stelle mit dem Computer verbunden, bei der
Installation des USB-Treibers als Quellver-
zeichnis die mitgelieferte CD wahlen.

Windows ist ein registriertes Warenzeichen der Microsoft Corporation in den
USA und anderen Lédndemn. Mac OS ist ein registriertes Warenzeichen von
Apple Computer, Inc. in den USA und anderen Léndern.

2.1.1 Hinweis zur Ethernet-Schnittstelle

Die Ethernet-Schnittstelle des Geréts er-
laubt nur eine Ubertragungsrate von max.
10 Megabit/s. Bei Netzwerkgeraten, die
nur 100 Megabit/s unterstitzen (z.B.
FRITZ!Box 3370), muss deshalb ein
10/100-Switch  zwischengeschaltet wer-
den.

2.2 Steuerprogramm aufrufen

1) Auf dem Computer das Steuerpro-
gramm ,IMG Stage Line DSP Control-
ler” aufrufen.

Es erscheint ein Fenster zur Eingabe
des Passwortes fiir den Start des Pro-
gramms. Die Vorgabe ist ,monacor”.
Das Passwort kann aber spater vom
Anwender geandert werden (== Kap.
2.2.2).

2) Das Passwort eingeben (ohne Anfih-
rungszeichen und unter Beachtung der
Schreibweise).

Bei falsch eingegebenem Passwort
erscheint die Meldung ,Invalid pass-
word!“. In diesem Fall die Meldung
bestatigen und das Passwort erneut ein-
geben.

Das Ubersichtsfenster (Abb. 6) wird ange-
zeigt. Darin erscheint eine Liste aller ver-
bundenen Geréte.

In der oberen Zeile ,All Units® wird in
Klammern angegeben, wieviele Gerate
momentan ,online“ sind, d.h. in aktiver
Verbindung mit dem Computer stehen.
Darunter gibt es fur jedes Geréat eine Zeile
mit verschiedenen Informationen und
Funktionen in den im Folgenden beschrie-
benen Spalten:

1. Schaltflache ® zum Stummschalten
des Geréts
Wahrend der Stummschaltung ist die
Schaltflache rot. Zum Wiedereinschal-
ten des Tons erneut auf die Schaltflache
klicken. Das Klicken auf die Schaltflache

2 IMG Stage Line DSP Controller

File  Tools  Help

0 in der Zeile ,All Units“ fUhrt zur gleich-
zeitigen Stummschaltung aller verbun-
denen Geréte.

. Schaltflache (® zum ldentifizieren eines

Geréts

Nach dem Klicken auf die Schaltfla-
che blinkt diese flr einige Sekunden
und mit ihr alle LEDs am Gerat.

. Symbol @ fur den Betriebszustand des

Gerats

Es ist im Betrieb des Gerats grin,
im Bereitschaftsmodus (Standby) rot.
Durch Klicken auf das Symbol lasst sich
das Gerat in den anderen Zustand
umschalten. Bei einer unterbrochenen
Verbindung ist das Symbol grau. Wah-
rend beim Einschalten eines Gerats
eine neue Verbindung aufgebaut wird,
erscheint am Ende der Liste vorUberge-
hend eine zusatzliche Zeile ,Startup...”
mit dem Symbol ®@.

. Die beiden senkrechten Balken || stel-

len eine einfache Pegelanzeige fir den
Eingang und den Ausgang eines Geréts
dar.

. Anzeige des Geratenamens

Der voreingestellte Name kann zur
Unterscheidung gleicher Gerate hier
oder im Konfigurationsfenster (1= Kap.
2.3.2) geandert werden.

. Anzeige der Hardware-Adresse (MAC-

Adresse) der Netzwerk- oder USB-
Schnittstelle des Geréats

Uber diese Adresse lasst sich ein
Gerat immer eindeutig identifizieren.

. Anzeige der IP-Adresse eines Uber ein

Netzwerk verbundenen Gerats

Bei Geraten, die lUber USB ange-
schlossen sind, steht hier die Nummer
der USB-Schnittstelle. Bei unterbroche-
ner Verbindung steht an dieser Stelle
,Offline”.

. Schaltflache ® zum Aufruf des Konfigu-

rationsfensters (Abb. 8) fur ein Gerét,
das ,online” ist

In der Zeile ,All Units“ kann Uber die
Schaltflache &) die Liste der Geréte aus-
geblendet oder Uber ) wieder einge-
blendet werden.

o

All Units (3 units online)
IMG DSM-26LAN
IMG DSM-18LAN

IMG DSM-48LAN

DSP CONTROLLER

(6) Ubersichtsfenster

B8:96:74:01:22:E3
B8:96:74:01:23:A5
05:AB:F8:42:D5:FL

169.254.203.11
169.254.138.120
USE port 3




2.2.1 Gerategruppen

Mehrere Gerate kbnnen zur gemeinsamen
Steuerung in Gruppen zusammengefasst
werden. Sie kdnnen so z.B. gemeinsam
stummgeschaltet werden. Welche Para-
meter der gruppierten Gerdte gemeinsam
gesteuert werden, l&sst sich in den Einstel-
lungen der Gruppe festlegen. Die Zugeho-
rigkeit eines Gerats zu einer Gruppe kann
jederzeit ge&ndert werden.

2.2.1.1 Neue Gruppe bilden

1) Zum Anlegen einer neuen Gruppe den
Menlpunkt ,Tools # New Group“ aufru-
fen.

2) Im angezeigten Fenster in das Feld
+Enter the name of the new group:“ den
gewulnschten Gruppennamen einge-
ben.

In der Liste wird jetzt eine zusatzliche
Zeile fir die Gruppe gezeigt (Zeile
LGroup: ...“, 1= Abb. 7).

3) Uber die Schaltfliche @ kann eine
Gruppe eingerichtet oder geandert wer-
den. Es kénnen Mitglieder zugeflgt
oder entfernt werden und es lassen sich
Gruppenname und Kopplungseigen-
schaften andern.

In der Zeile ,Group: ...“ wird jeweils
die aktuelle Anzahl der Gruppenmitglie-
der angezeigt (units).

4) Uber die Schaltfliche & am Ende der
Zeile ,Group: ...“ kann direkt unter der
Zeile eine Liste aller Gruppenmitglieder
gezeigt oder Uber & wieder ausgeblen-
det werden.

2.2.1.2 Gruppe ldschen

Zum Loéschen einer Gruppe in der entspre-
chenden Zeile auf die Schaltflache & kli-
cken (1=° Abb. 7). Es erscheint eine Sicher-
heitsabfrage zur Bestétigung des L&sch-
vorgangs. Wenn der Gruppe zu diesem
Zeitpunkt Gerate zugeordnet sind, er-
scheint eine zusétzliche Sicherheitsab-
frage.

% IMG Stage Line DSP Controller

File  Tools  Help

2.2.2 Programmpasswort dndern

Um das Passwort fir den Start des Pro-
gramms zu andern:

1) Den Menlpunkt ,Tools » Change Soft-
ware Password” aufrufen.

2) Im angezeigten Fenster in das Feld
sEnter Old Password:“ das bisherige
Passwort eingeben (vom Werk vorein-
gestellt ist ,monacor®).

3) Im nun angezeigten Fenster in das Feld
+Enter New Password:“ das neue Pass-
wort eingeben.

4) Im anschlieBend angezeigten Fenster in
das Feld ,Confirm New Password:" das
neue Passwort zur Bestatigung noch
einmal eingeben und gut merken!

2.2.3 Demo-Modus

Auch wenn kein Gerat mit dem Computer
verbunden ist, lasst sich zu Demonstrati-
onszwecken ein virtuelles Gerat erzeugen.
Dazu den Menlpunkt ,Tools » Enter Demo
Mode“ aufrufen.

In der Liste erscheinen jetzt verschie-
dene virtuelle Gerate mit der zusatzlichen
Bezeichnung ,DEMO...“. Wie bei realen
Geraten kann hier Uber die Schaltflache ¢
das Konfigurationsfenster aufgerufen wer-
den (1= Abb. 8).

Um die virtuellen Geréate wieder aus der
Liste zu entfernen, den MenUpunkt ,Tools
» Leave Demo Mode“ aufrufen.

2.2.4 Firmware Update

Fir eine reibungslose Kommunikation zwi-
schen dem Steuerprogramm und einem
Gerat missen beide zueinander passende
Versionen haben. Liegt das Steuerpro-
gramm in einer neueren Version vor, kann
die Firmware (Betriebssystem) der Gerate
Uber das Steuerprogramm aktualisiert wer-
den. Dabei gehen alle in den Geraten
gespeicherten Einstellungen verloren. Sol-
len die Einstellungen erhalten bleiben,
mussen sie vor der Aktualisierung auf dem

CEX

Group: My_group (2 units)
IMG DSM-26LAN
IMG DSM-48LAN

IMG DSM-26LAN
IMG DSM-48LAN
IMG DSM-48LAN

x

x

®

[ &l Units (3 units online)
x

x

DSP CONTROLLER

@ Ubersichtsfenster mit Gruppe

BE:96:701:22E3 1
B8:96:74:01:23:45 1

B8:96:74:01:22:E3
B8:96:74:01:23:A45
05:AB:F8:42:D5:FL

7 %=

54.203.11

Enabled
69,2
69.254.138.120

169.254.203.11
169.254.138.120
USB port 3

fmy)

5&5& Lise

Computer gesichert werden (s Kap.
2.3.11).

Hinweis: Eine Firmware-Aktualisierung geschieht
auf eigenes Risiko. Nach einem Update kann die
Funktionsweise des Gerétes von der Beschrei-
bung in der Bedienungsanleitung abweichen.

VORSICHT: Schalten Sie die Signalquel-
len aus oder reduzieren Sie deren Aus-
gangspegel, damit es nach dem Zurtickset-
zen der Einstellungen nicht zu unerwartet
hoher Lautstérke kommt.

Um die Firmware eines Gerats auf den
neuesten Stand zu bringen, den Menu-
punkt ,Tools ®Enable Update* aufrufen.
Hinter den Geraten in der Liste wird jetzt
das Symbol ©® angezeigt. Bei einem
grauen Symbol ist kein Update moglich
(z. B. weil die Firmware des Geréts bereits
aktuell ist oder weil die Zugriffsrechte fur
das Update nicht ausreichen).

Hinweis: Bei einem Uber die USB-Schnittstelle
verbundenen Gerat ist ein Update nicht mdglich.
Verbinden Sie das Gerat flr das Update Uber die
Ethernet-Schnittstelle.

Ist das Symbol orange, kann ein Update
erfolgen:

1) In der Zeile des gewinschten Geréts
auf die Schaltflache @ klicken.

2) Es erscheint ein Hinweis, dass das
Gerat wahrend der mehrschrittigen
Aktualisierung nicht ausgeschaltet oder
die Verbindung getrennt werden darf.
Schlagt die Aktualisierung fehl, muss sie
erneut gestartet werden.

Die Aktualisierung mit [OK] starten
oder mit [Cancel] abbrechen.

3) Nach erfolgter Aktualisierung wird noch
eine Meldung angezeigt. Diese eben-
falls bestéatigen.

Um in der Liste die Update-Symbole wie-
der auszublenden, den MenUpunkt , Tools
» Disable Update“ aufrufen.

Hinweis: Bei einem Rlcksetzen der Einstellun-
gen auf die Werksvorgaben sind auch die Netz-
werkeinstellungen und die Passworter des Geréts
betroffen, d. h. es kann méglicherweise zunachst
vom Computer nicht mehr auf das Gerat zugegrif-
fen werden.

Ein Update der Firmware ist ebenfalls tber
das MenU des Konfigurationsfensters mog-
lich (Hardware » Firmware Update), wenn
sich das Gerét in der Zugriffsebene ,Deve-
lopment” befindet.

2.2.5 Programm beenden

Zum Beenden des Programms den Menu-
punkt ,File »Quit“ aufrufen oder das Pro-
grammfenster schlieBen.

Deutsch
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2.3 Gerat konfigurieren

Achtung!

Der Signalprozessor ist in Verbindung mit
dem Steuerprogramm ein effektives Werk-
zeug, mit dem sehr feine, aber auch gra-
vierende Anderungen der Ubertragungsei-
genschaften der Beschallungsanlage mog-
lich sind.

Jede Anderung der Parameter sollte
deshalb mit Bedacht und Sachverstand
vorgenommen werden. Extreme Anderun-
gen der Einstellungen kénnen schlimms-
tenfalls zur Schadigung der Lautsprecher
fahren.

Zur Konfiguration des Gerats in der Liste
bei dem Gerét auf die Schaltflache ) kli-
cken (1= Abb. 6, 7).

Das Konfigurationsfenster (Abb. 8) mit
der Hauptansicht (MAIN) wird flr das
gewahlte Gerat angezeigt. Auf der linken
Seite wird als Farbfeld neben LINK B der
Verbindungsstatus des Geréats angezeigt.
Bei griinem Feld besteht eine Datenverbin-
dung. Bei rotem Feld ist die Verbindung
unterbrochen, das Andern einer Einstellung
ist dann nicht méglich. Bei einem Versuch
erscheint eine entsprechende Meldung.

Auf dem Bildschirm geénderte Einstel-
lungen werden bei bestehender Verbin-
dung sofort zum Gerét Ubertragen. Die Ein-
stellungen kénnen auf dem Computer und
im Gerat (1 Kap. 2.3.2) als Preset gespei-
chert werden. Zudem kann festgelegt wer-
den, ob beim Einschalten des Gerats
immer ein bestimmtes Preset geladen wer-
den soll oder der letzte Zustand vor dem
Ausschalten (i Kap. 2.3.10).

Uber die Schaltflachen der Seitenleiste
kann auf die anderen Ansichten (X-OVER,
IN 1-2/4, OUT 1-6/8) umgeschaltet wer-
den (Abb. 9—11). Uber die Schaltflache
MAIN gelangt man zurGck zur Hauptan-
sicht.

2.3.1 Signalweg

In der Abbildung 3 ist der Signalweg durch
das DSM-26/48LAN als Blockdiagramm
dargestellt. Von den Eingédngen durchlau-
fen die Signale nach der Analog-Digital-
Umwandlung (in den Eingdngen A und B
ist alternativ das Signal des Digital-
eingangs AES/EBU wahlbar) den Ein-
gangsverstarker (GAIN), ein Hoch- und
Tiefpassfilter (HPF+LPF), die 10-bandige
Klangeinstellung (PEQ), die Signalverzé-
gerung (DELAY), einen Dynamikkompres-
sor (COMPRESSOR) und die Pegelbe-
grenzung (LIMITER). FUr jeden der Aus-
gangskanéle kann ein eigenes Mischsignal
aus den bearbeiteten Eingangssignalen er-
zeugt werden. Dieses flhrt dann Uber ein
Hoch- und Tiefpassfilter (HPF+LPF), eine
10-bandige Klangkorrektur (PEQ), eine
Signalverzdgerung (DELAY), einen Dyna-
mikkompressor (COMPRESSOR), eine
Pegelbegrenzung (LIMITER) sowie die
Maoglichkeit der Phasenumkehr (PHASE
INVERT) zur Digital-Analog-Umwandlung
und dann zu den Ausgéngen.

Die Parameter zu den gezeigten BI6-
cken konnen in den Ansichten MAIN,
X-OVER, IN 1-2/4 und OUT 1-6/8 ein-
gestellt werden. Fur einige ist der Zugriff
von mehreren Ansichten méglich.

Hinweis: Die Einstellméglichkeiten sind von den

Zugriffsrechten der aktuellen Zugriffsebene ab-

hangig (1= Kap. 1). Um alle Einstellungen durch-

% 1MG DSM-26L4N (B8: 96:74:01:22:E3) (Development Mode)
File  Hardware P

SP CONTROLLER

LOCAL PRESETS
| Store | Load

UNIT PRESETS E

10: My Stereo 3-W L
Load

LINK

IMG DSM-26LAH (B8:96
UNIT NAME
IMG DSM-26LAH

LINK ®
[ 0.00 | 0.00 | Mute | Mute | 0.00 | 0.00 | 989 | 0.89 | 345 | 3.45 |

MUTE— &

fhren zu kénnen, sollte beim ersten Aufruf des
Steuerprogramms in die Zugriffsebene ,Develop-
ment“ gewechselt werden. Von hier aus kénnen
dann, entsprechend dem fir die Bedienung des
Gerats geplanten Personenkreis, die Zugriffs-
rechte und Passworter fir die anderen Zugriffs-
ebenen festgelegt werden (1 Kap. 2.3.7).

IR T T Ry CE N ) G L T L |
T

@ 1@ 44 @

2 T 2 2 2 2 2 T 2

@t (R ] |- [ltow|Rrow]itud [Ria |LHigh]R bigh]

(8 Ansicht MAIN
2.3.2 Ansicht MAIN (Abb. 8)

HE Schaltflichen zum Umschalten der An-
sicht

E LOCAL PRESETS
Speichern ,Store” der aktuellen Einstel-
lungen als Presets auf dem Computer
(wie Menipunkt ,File »Save) und
Laden ,Load“ vom Computer (wie Me-
nupunkt ,File » Open®).

H UNIT PRESETS
Speichern ,Store” der aktuellen Einstel-
lungen als Presets im Geréat und Laden
,Load“ eines im Gerat gespeicherten
Presets
Speicherplatz im Listenfeld wahlen und
im oberen Feld einen Namen eingeben.

A LINK - Verbindungsstatus
Grin = verbunden
Rot = nicht verbunden
Fir den Wechsel zu einem anderen
Gerat dieses im Listenfeld wahlen.

B UNIT NAME — Name des Geréts; kann
durch Uberschreiben geéndert werden

A GAIN-Regler zur Lautstarkeeinstellung
fur die Eingénge, daneben Pegel-Anzei-
gen, darunter Eingabe-/Anzeigefelder
fur den Verstarkungswert

GAIN-Regler zur Lautstérkeeinstellung
fur die Ausgénge, daneben Pegel-
Anzeigen, darunter Eingabe-/Anzeige-
felder fur den Verstarkungswert

B LINK-Schalter zur Kopplung der Ein-
génge (jeweils paarweise)

Bl LINK-Schalter zur Kopplung der Aus-
gange (jeweils paarweise)

MUTE-Schalter zum Stummschalten
des jeweiligen Ein- oder Ausgangs

Eingabefelder zur Benennung der Ein-
und Ausgange

2.3.3 AnsichtIN 1-2/4 (Abb. 9)

[ Schaltflaichen zum Umschalten der An-
sicht

B Kurvendarstellung des Amplituden-Fre-
quenzgangs
Zu jedem der 10 parametrischen Filter
gehdrt ein Bezugspunkt (kleines Qua-
drat mit der Filternummer) und eine Fre-
quenzkurve in einer eigenen Farbe. Der
resultierende Frequenzgang aller akti-
ven Filter ist als weiBe Kurve dargestellt.

Die Filterparameter kénnen zum Teil
auch grafisch eingestellt werden. Dazu
mit der Maus den jeweiligen Bezugs-
punkt verschieben:

— Anderung der Frequenz durch hori-
zontales Verschieben

— Anderung der Verstarkung durch verti-
kales Verschieben

— Anderung der Filtergiite/Bandbreite
durch horizontales Verschieben mit
der rechten Maustaste

— Ein- oder Ausschalten eines Filters
durch Doppelklick auf den Bezugs-
punkt

@ Ein-/Ausblenden der Werte aller
aktiven Filter

Q, Feineinstellmodus ein-/ausschalten

& vergroBerte Darstellung = Vollbild-
darstellung; Rickkehr zur kleinen
Darstellung mit %

B2 Kurven als Bilddatei (PNG) spei-
chern

i GAIN-Regler zur Lautstarkeeinstellung
fur den entsprechenden Eingang, dane-
ben Pegel-Anzeige, darunter Eingabe-/
Anzeigefeld fur den Verstarkungswert
(gleiche Wirkung wie @)



[l Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

M Listenfeld TYPE zur Auswahl des Filter-
typs

Eingabe-/Anzeigefeld FREQ fir die Fil-
terfrequenz (Werte in Hz eingeben)

B Eingabe-/Anzeigefeld Q/BW fiir die Fil-
tergite/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

[ Eingabe-/Anzeigefeld GAIN fir die
Pegelanhebung/-absenkung des Filters

Hl Hochpassfilter HPF: Eingabe-/Anzeige-
feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off* <20 Hz)

Bl Hochpassfilter HPF: Listenfeld fir die
Auswahl des Filtertyps

A Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

EH Tiefpassfilter LPF: Listenfeld fiir die
Auswahl des Filtertyps

Bl MUTE-Schalter zum Stummschalten
des entsprechenden Eingangs (gleiche
Wirkung wie )

2.3.4 Ansicht OUT 1-6/8 (Abb. 10)

B Schaltflachen zum Umschalten der An-
sicht

Hl Regler MIXER zum Einstellen des
Mischsignals aus den Eingangskanélen
fir diesen Ausgang, daneben Pegel-
Anzeigen, darunter Eingabe-/Anzeige-
felder fur den Verstarkungswert

Bl Kurvendarstellung des Amplituden-Fre-
quenzgangs
(Beschreibung 1= Kap. 2.3.3, )

B GAIN-Regler zur Lautstarkeeinstellung
fir den entsprechenden Ausgang,
daneben Pegel-Anzeige, darunter Ein-
gabe-/Anzeigefeld fur den Verstér-
kungswert (gleiche Wirkung wie H)

B Schalter ON jeweils zum Aktivieren/
Deaktivieren eines Filters

B Listenfeld TYPE zur Auswahl des Filter-
typs

EH Eingabe-/Anzeigefeld FREQ fir die Fil-
terfrequenz (Werte in Hz eingeben)

H Eingabe-/Anzeigefeld Q/BW fiir die Fil-
terglte/Bandbreite (Umschalten durch
Klicken auf Q oder BW)

Eingabe-/Anzeigefeld GAIN fir die
Pegelanhebung/-absenkung des Filters

B Hochpassfilter HPF: Eingabe-/Anzeige-

feld fur die Grenzfrequenz (Werte in Hz
eingeben, ,Off* < 20 Hz)

B Hochpassfilter HPF: Listenfeld fir die
Auswahl des Filtertyps

% |MG DSM-26LAN (B8:96:74:01:22:E3) (Development Mode)

File Hardware Preset  Help

ON

TYPE FREQ Q
640Hz

MUTE O

1.22kHz

umiren [25 7]

2,56kHz L

§.12kHz

(0.0 [ 24.00d0u | 50ams |

THR REL

10.9 kHz

(9)Ansicht IN 1

8 Schaltfliche COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fiir den
Kompressor des entsprechenden Ein-
gangs (1= Kap. 2.3.6)

H Drehregler DELAY mit Eingabe-/Anzei-
gefeld flr die Einstellung der Signalver-
z6gerung des entsprechenden Ein-
gangs; im Listenfeld darunter die Einheit
wahlen: Zeit oder Entfernung (zur auto-

% IMG DSM-26LAN (BB:96:74:01:22:E3) (Development Mode)

File Hardware Preset  Help

15
10/ 20 50 100 200\ 500 1k 2k Sk 10k 20k

MUTE : =

GAIN

matischen Berechnung der Schalllauf-
zeit)

Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

B Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld fur die
Ruckstellzeit (release time)

TYPE FREQ L] GAIN
640Hz

woesr [ 2

1.28kHz

LmeR

2.56kHz L

5.12kHz

Ely - Ea- Flg-
(0.0 [ 12.00d5u | s0aks |

THR

10.2 kHz

Butterworth 13dB = v

(19 Ansicht OUT 1

M Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off“ > 20 kHz)

O Tiefpassfilter LPF: Listenfeld fir die
Auswabhl des Filtertyps

[} MUTE-Schalter zum Stummschalten
des entsprechenden Ausgangs (gleiche
Wirkung wie M)

Schalter INVERT flr die Phasenumkehr

M@ Schaltflache COMPRESSOR zum Auf-
rufen des Konfigurationsfenster fur den
Kompressor des entsprechenden Aus-
gangs (i Kap. 2.3.6)

[H Drehregler DELAY mit Eingabe-/Anzei-
gefeld fiur die Einstellung der Signalver-
zOgerung des entsprechenden Aus-
gangs; im Listenfeld darunter die Einheit
wabhlen: Zeit oder Entfernung (zur auto-
matischen Berechnung der Schalllauf-
zeit)

M Pegelbegrenzung LIMITER: Drehregler
THR mit Eingabe-/Anzeigefeld fir den
Schwellwert (threshold)

Pegelbegrenzung LIMITER: Drehregler
REL mit Eingabe-/Anzeigefeld fur die
Ruckstellzeit (release time)
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2.3.5 Ansicht X-OVER (Abb. 11)

[ Schaltflachen zum Umschalten der An-
sicht

9 IMG DSM-26LAN (B8:96:74:01:22:E3) (Development Mode)

File Hardware Preset  Help

[ Kurvendarstellung des Amplituden-Fre-
quenzgangs fiur alle Hoch- und Tief-
passfilter der Ausgénge
Durch die Darstellung aller Ausgénge in —
einem Diagramm werden bei der Erstel- L £ S ©
lung einer Frequenzweiche die Fre-
quenzibergénge deutlich. (Fir gekop-
pelte Ausgénge wird jeweils nur eine Fil-
terkurve angezeigt.)

Die Grenzfrequenzen der Filter wer- i 150Hz 150Hz
den durch dreieckige Marken oberhalb W sut13a3 v
der Kurve dargestellt. Durch Verschie-
ben einer Marke mit der Maus l&sst sich
die Frequenz andern (alternativ zur

MUTE

BOOOOOCUO

PHASE INVERT

Bl 2z 2222
CROSSOVER
5 6
3.22kHz 3.22kHz

But 1§d6 Bes12dB v Bes12dB v

3.22kHz 3.22kHz Off Off

Bes 12dB v Bes12dB v

-9.39dB -9.89dB

0.0ms 0.0ms

numerischen Eingabe in BI/H).

Bl Hochpassfilter HPF: Eingabe-/Anzeige-
feld fir die Grenzfrequenz (Werte in Hz
eingeben, ,Off < 20 Hz)

(gleiche Wirkung wie E)

Hochpassfilter HPF: Listenfeld flr die
Auswahl des Filtertyps (gleiche Wirkung
wie H)

B Tiefpassfilter LPF: Eingabe-/Anzeigefeld
fur die Grenzfrequenz (Werte in Hz ein-
geben, ,Off* > 20 kHz)

(gleiche Wirkung wie i)

2.3.6 Fenster COMPRESSOR

== MG DSM-26L4N (B8:96... [= |[0)(X]
Preset  Help
VU & GR

File  Hardware

COMPRESSOR
Threshold

.

[ 50ms |

Release

Ratio

Makeup Gain

(12 Kompressorkonfigurationsfenster

@D Ansicht X-OVER

B Tiefpassfilter LPF: Listenfeld fur die
Auswahl des Filtertyps (gleiche Wirkung
wie [)

Bl Eingabe-/Anzeigefeld G (gain) fur die
Einstellung der Lautstédrke des Aus-
gangs (gleiche Wirkung wie H und )

H Eingabe-/Anzeigefeld D (delay) fir die
Einstellung der Signalverzégerung des
Ausgangs (gleiche Wirkung wie [H)

H Pegelanzeigen firr die Ausgéange

@l Schaltfliche BACK flhrt zuriick zur vor-
herigen Ansicht

Pegelanzeige VU und Verstéarkungsmin-
derung GR (gain reduction)

& Drehregler Threshold mit Eingabe-/
Anzeigefeld fir den Schwellwert

[ Drehregler Attack mit Eingabe-/Anzei-
gefeld fir die Ansprechzeit

[ Drehregler Hold mit Eingabe-/Anzeige-
feld fur die Haltezeit

[ Drehregler Release mit Eingabe-/Anzei-
gefeld fur die Ruckstellzeit

[ Drehregler Ratio mit Eingabe-/Anzeige-
feld fir das Kompressionsverhaltnis

Drehregler Makeup Gain mit Eingabe-/
Anzeigefeld fur den Pegelverlustaus-
gleich

Schalter LINK zur Kopplung der Aus-
gange (jeweils paarweise, gleiche Wir-
kung wie B)

Bl MUTE-Schalter zum Stummschalten
des jeweiligen Ausgangs (gleiche Wir-
kung wie )

Schalter PHASE INVERT fir die Pha-
senumkehr des jeweiligen Ausgangs
(gleiche Wirkung wie H)



2.3.7 Zugriffsrechte verwalten

2.3.7.1 Passworter eingeben

Nach dem Einschalten des Geréts ist nor-
malerweise die Zugriffsebene ,User” ge-
wahlt (== Kap. 1). Um in eine hdhere
Zugriffsebene zu gelangen, das entspre-
chende Passwort Uber den MenUpunkt
~Hardware » Enter Password“ eingeben.

2.3.7.2 Passworter andern

Zum Andern des Passwortes der aktuellen
Zugriffsebene oder, in der Ebene ,Deve-
lopment”, zum Andern der Passwérter fiir
eine niedrigere Zugriffsebene den Menu-
punkt ,Hardware #Configure »Change
Password“ bzw. ,Hardware »Passwords
» User/Admin/Developer Password“ aufru-
fen.

Fir das Passwort der aktuellen Ebene
ist es erforderlich, zunachst das bisherige
Passwort einzugeben, dann das neue, wel-
ches dann noch einmal zur Bestétigung
eingegeben werden muss. Passworter fur
niedrigere Zugriffsebenen kdnnen dage-
gen direkt eingegeben werden und werden
auch angezeigt.

In der Ebene ,Development® ist es
zudem mdglich, einzelne Presets mit
gesonderten Passwoértern zu versehen.
Vor dem Speichern eines Presets miissen
dafiir die gewlinschten Einstellungen uber
das Menl ,Preset »Passwords »Admin
Password“ und ,,... » Developer Password*
vorgenommen werden.

Wichtig: Mit dem Preset gespeicherte
Passworter haben Vorrang vor den System-
passwortern. Wird ein Preset aufgerufen,
das mit individuellen Passwértern fur die
Zugriffsebenen ,,Administrator und ,Deve-
lopment* gespeichert wurde, sind die Sys-
tempassworter flr diese Ebenen ungliltig.

2.3.7.3 Zugriffsrechte dndern

Uber den Meniizweig ,Hardware » Confi-
gure » Access Rights” kdnnen die Zugriffs-
rechte fir die niedrigeren Zugriffsebenen
festgelegt werden. Die Tabelle (Abb. 13)
zeigt die Mdglichkeiten und Voreinstellun-
gen fur die einzelnen Ebenen.

Eine Besonderheit stellt der Zugriff auf
die Einstellungen der Ein- und Ausgangs-
parameter dar. Die Zugriffsrechte hierfur
(Access Input/Output Channel) werden
ausschlieBlich in der Ebene ,Development®
mit dem jeweiligen Preset gespeichert. Vor
dem Speichern eines Presets missen
daflr die gewlinschten Einstellungen uber
das jeweilige MenU ,Preset #Access
Rights # Locked Access Rights®, ,,... » User
Access Rights“ und ,,... »Admin Access
Rights” vorgenommen werden.

2.3.8 Locked State

Um in die unterste Zugriffsebene ,Locked
State” zu gelangen, den Menlpunkt ,Hard-
ware #Lock Unit* aufrufen. Eine Meldung
wird angezeigt, die darauf hinweist, dass
diese Ebene nur Uber die Eingabe eines
korrekten Passworts einer héheren Ebene
wieder verlassen werden kann. Die Mel-
dung mit OK bestatigen.

2.3.9 Standby

Um das Gerat in den Bereitschaftsmodus
L~otandby” zu versetzen, den MenUpunkt
,Hardware » Go to Standby“ aufrufen. Fur
die Ruckkehr zum normalen Betrieb dann
den Menipunkt ,Hardware » Exit Standby*
aufrufen (vgl. Kap. 2.2).

2.3.10 Einschalt-Preset festlegen

Um festzulegen, mit welchen Einstellungen
das Gerat einschalten soll, den Menupunkt
.Hardware » Configure » Power On Preset”
aufrufen.

Im Listenfeld des angezeigten Fensters
das Preset wahlen, das jedes Mal nach
dem Einschalten des Gerats automatisch
geladen werden soll oder die Option ,Last
Setting“, damit das Gerat nach dem Ein-
schalten immer die letzten vor dem Aus-
schalten durchgefiihrten Einstellungen be-
halt.

2.3.11 Sichern/Zuriickladen aller Presets
Zum Sichern aller Presets des Gerats auf
dem Computer den Menipunkt ,File
» Backup Presets” aufrufen und den Spei-
cherort (Ordner) wahlen.

Zum spateren Zuruckladen der gesi-
cherten Presets den Menlpunkt ,File
» Restore Presets” aufrufen.

3 Steuerung liber einen
Tabletcomputer

Zusétzlich zum mitgelieferten Steuerpro-
gramm fur einen PC ist auch ein Steuerpro-
gramm fir Tabletcomputer unter der
Bezeichnung ,DSP-CONTROL“ im ,App
Store“ des Computerherstellers Apple Inc.
erhéltlich.

Anderungen vorbehalten.

Zugriffsrechte

Zugriffsebenen

Access Rights

Development Administrator

User Locked State

Load Presets

v

] O

Save Presets

| O

Load Factory File

|
v ]
v

v

Create Factory File

Enable Display Lock Control

=

Change User Access Rights

Change Locked Access Rights

Change Unit Name

ANIANIENIENIRN

O

Lock Automatically After Power Cycle

Change Unit Configuration
(Network, AutoStandby, Startup Preset)

Load an Empty Preset

Upgrade the Unit Firmware

Access Input Channel

Access Output Channel

HIORXRF ®H |OFEEE>

NENESENERN

HOO0OXR X OR”QF

ojogo] o

@Mégliche Zugriffsrechte und deren Voreinstellungen

Diese Bedienungsanleitung ist urheberrechtlich fir MONACOR® INTERNATIONAL GmbH & Co. KG
geschlitzt. Eine Reproduktion fiir eigene kommerzielle Zwecke — auch auszugsweise — ist untersagt.
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1 Access Levels

If you have restricted access rights, you
may not be able to execute all the opera-
tions described in the instruction manual.

Four access levels with different rights
are available for configuring the unit. The
levels are accessed by different passwords.
The passwords are entered at the unit

; -4) or via the control program
(menu item “Hardware » Enter Password”,
15 chapter 2.3.7.1).

The following table shows the access lev-
els in descending order and the correspond-
ing passwords:

Access level Password*
Development Dev_dsm_
Administrator Adm_dsm_
User monacor
Locked State —

(5) Factory-set passwords

*These passwords are factory-set; the user can
change these passwords in the respective
access level or in a higher access level. — Make
sure to remember the changed passwords!

The passwords are saved in the unit. When
the unit is switched on, it will usually be in
the access level “User”. When a password
is entered, the unit will be in the correspond-
ing access level until the unit is switched
off, a different password is entered or the
access level “Locked State” is called up. To
go to the access level “Locked State”,
either use the menu item Fooess
L -1 at the unit or the menu
item “Hardware » Lock Unit” of the control
program.

The operating options of a level can be
restricted in the higher level. These restric-
tions, however, can only be made in the
control program (1= chapter 2.3.7.3).

2 Control Program

2.1 Installing the PC software

To install the control program supplied,
a computer with the operating system
Windows XP with Service Pack 2 or with a
later Windows version or with Mac OS X ver-
sion 10.5.8 or later and an Ethernet interface
or USB interface is required. The screen res-
olution should be at least 1024 x 768 pixels.
To install the PC software, start the installa-
tion program “Setup.exe” or “Setup [...].msi”
or (for Mac OS X)) “[...] Controller.mpkg” on
the CD supplied and then follow the instruc-
tions of the installation program.

If the unit is connected to the computer
via the USB interface, select the CD sup-
plied as the source directory when installing
the USB driver.

Windows is a registered trademark of Microsoft Corporation in the United

States and other countries. Mac OS is a registered trademark of Apple Com-
puter, Inc. in the United States and other countries.

2.1.1 Note concerning the

Ethernet interface
The Ethernet interface of the unit only sup-
ports a bit rate of up to 10 megabit/s.
Therefore, a 10/100 switch must be in-
serted for network units that only support
100 megabit/s (e. g. FRITZ!Box 3370).

2.2 Calling up the control program
1) At the computer, call up the control pro-
gram “IMG Stage Line DSP Controller”.
A password-entry window will appear
for starting the program. The factory-set
password is “monacor” which, however,
can later be changed by the user
(r=° chapter 2.2.2).

2) Enter the password (without quota-
tion marks and observing the correct
spelling).

If the password is not correctly en-
tered, the message “Invalid password!”
will appear. In this case, confirm the
message and enter the password again.

The overview window (fig. 6) will appear,
displaying a list of all units connected.

In the upper row “All Units”, the text in
parenthesis specifies the number of units
that are currently “online”, i.e. that are
actively connected to the computer. The
rows below the upper row contain the fol-
lowing columns with various information
and functions for the individual units:

1. Button ® to mute the unit
The button will be red when the unit is
muted. To unmute the sound, click the
button again. To mute all units con-
nected at the same time, click the button
@ in the row “All Units”.

2. Button (® to identify a unit
When this button is clicked, the button
and all LEDs at the unit will flash for a
few seconds.

2 IMG Stage Line DSP Controller

File  Tools  Help

. Symbol @ for the operating mode of the

unit

When the unit is in operation, the
symbol will be green; when the unit is in
the standby mode, the symbol will be
red. Click the symbol to change the
mode of the unit. The symbol will be
grey when the connection is interrupted.
When a unit is switched on and a new
connection is being established, an
additional row (“Startup...”) with the
symbol @ will temporarily appear at the
end of the list.

. The two vertical bars || are simple level

indicators for the input and the output of
the unit.

. Indication of the unit name

For easier distinction of the same
units, the predefined name can be
changed here or in the configuration
window (s chapter 2.3.2).

. Indication of the hardware address

(MAC address) of the network interface
or USB interface of the unit

With this address, a unit can always
be clearly identified.

. Indication of the IP address of a unit

connected via the network

For units connected via USB, the
number of the USB interface will be indi-
cated. When the connection is inter-
rupted, “Offline” will be shown here.

. Button ® to call up the configuration

window (fig. 8) for a unit that is “online”

To hide the list of units, click the but-
ton & in the row “All units”. To show the
list again, click the button ).

All Units (3 units online)
IMG DSM-26LAN
IMG DSM-18LAN

IMG DSM-48LAN

DSP CONTROLLER

@ Overview window

B8:96:74:01:22:E3
B8:96:74:01:23:A5
05:AB:F8:42:D5:FL

169.254.203.11
169.254.138.120
USE port 3




2.2.1 Unit groups

Multiple units may be grouped so that they
can be jointly controlled (e. g. jointly muted).
The group settings allow the definition of
the parameters that are to be jointly con-
trolled. It is always possible to add units to
the group or remove units from the group.

2.2.1.1 Creating a new group

1) To create a new group, call up the menu
item “Tools » New Group”.

2) A new window will be displayed. In the
field “Enter the name of the new group?”,
enter the group name desired.

A new row for the group will be added
to the list (row “Group: ...”, 1= fig. 7).

3) To create or change a group, use the
button @. It is possible to add or remove
members, and the group name and the
linkage characteristics can be changed.

The row “Group: ...” indicates the cur-
rent number of group members (units).

4) Use the button @ at the end of the row
“Group ...” to show a list of all group
members directly beneath this row. To
hide the list again, click the button ©.

2.2.1.2 Deleting a group

To delete a group, click the button & in
the corresponding row (e fig. 7). A confir-
mation box will appear, asking you to con-
firm the deletion. If units are contained in the
group, another confirmation box will appear.

% IMG Stage Line DSP Controller

File  Tools  Help

2.2.2 Changing the program password
To change the password for starting the
program:

1) Call up the menu item “Tools » Change
Software Password”.

2) A new window will be displayed. In the
field “Enter Old Password:”, enter the
current password (the factory-set pass-
word is “monacor”).

3) A new window will be displayed. In the
field “Enter New Password:”, enter the
new password.

4) A new window will be displayed. In the
field “Confirm New Password:”, enter
the new password again to confirm it.
Make sure to remember the password!

2.2.3 Demo mode

Even when no unit is connected to the com-
puter, it is possible to create a virtual unit
for demonstration purposes. To do so, call
up the menu item “Tools »Enter Demo
Mode”.

Various virtual units with the additional
designation “DEMO ...” will be added to the
list. As for real units, the button ¢ can be
used to call up the configuration window
(r=r fig. 8).

To remove the virtual units from the list,
call up the menu item “Tools » Leave Demo
Mode”.

Group: My_group (2 units)
IMG DSM-26LAN
IMG DSM-48LAN

IMG DSM-26LAN
IMG DSM-48LAN
IMG DSM-48LAN

x

x

®

[ &l Units (3 units online)
¢

8

DSP CONTROLLER

@ Overview window with group

BE:96:701:22E3 1
B8:96:74:01:23:45 1

B8:96:74:01:22:E3
B8:96:74:01:23:A45
05:AB:F8:42:D5:FL

7 %=

54.203.11

Enabled
69,2
69.254.138.120

169.254.203.11
169.254.138.120
USB port 3

fmy)

5&5& Lise

2.2.4 Firmware update

The control program and the unit must be
equipped with matching firmware versions
to ensure smooth communication. If the
version of the control program is newer, the
firmware (operating system) of the units
may be updated via the control program.
With this update, all settings saved on the
units will be lost. To keep the settings, save
them on the computer (1> chapter 2.3.11)
before starting the update.

Note: Firmware updates are performed at your
own risk. After the update, the functions of the unit
may differ from those described in the instruction
manual.

CAUTION: Switch off the signal sources or
reduce their output level to avoid an unex-
pectedly high volume after the settings
have been reset.

To update the firmware of a unit, call up the
menu item “Tools » Enable Update”. In the
list, the symbol @ will appear after the
units. Units with a grey symbol cannot be
updated (e.g. because the units are
already equipped with the current firmware
version or because the access rights do not
allow for an update).

Note: Units connected via a USB interface cannot
be updated. To update these units, connect them
via the Ethernet interface.

Units with an orange symbol can be
updated:

1) Click the button @) in the row of the cor-
responding unit.

2) A message will appear which informs
you that it is not allowed to switch off the
unit or to interrupt the connection during
the multi-step update process. If the
update fails, it must be started again.

Click [OK] to start the update, or click
[Cancel] to cancel it.

3) Upon completion of the update, another
message will appear. Confirm this mes-
sage.

To hide the update symbols in the list, call
up the menu item “Tools # Disable Update”.
Note: Resetting to the factory settings will also
affect the network settings and the passwords of
the unit, i.e. it may initially not be possible to
access the unit via the computer.

When the unit is in the access level “Devel-
opment”, the firmware may also be
updated via the menu of the configuration
window (Hardware » Firmware Update).

2.2.5 Exiting the program
To exit the program, call up the menu item
“File » Quit” or close the program window.
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2.3 Configuring a unit

Attention!

Combined with the control program, the
signal processor is an effective tool for
making very detailed but also major
changes to the transmission properties of
the PA system.

Therefore, each modification to the
parameters should be performed with
care and expertise. At the worst, extreme
changes to the settings may damage the
speakers.

To configure a unit, click the button ®
(== figs. 6, 7) in the appropriate row of the
list.

The configuration window (fig. 8) with
the view MAIN for the unit selected will
appear. The colour field on the left-hand
side, next to LINK B, will indicate the con-
nection status of the unit. When the colour
field is green, a data connection has been
established. A red field will indicate that the
connection has been interrupted and that it
is not possible to modify settings. If the user
tries to make changes, an error message
will appear.

Any settings changed on the screen will
be instantly transferred to the unit provided
that a data connection exists. The settings
can be saved as presets on the computer
and the unit (i chapter 2.3.2). In addition,
it will be possible to define if the unit, when
being switched on, is to load a specific pre-
set or the state it was in when switched off
(i chapter 2.3.10).

To go to the other views (X-OVER,
IN1-2/4,0UT 1-6/8 (figs 9—11), use the
buttons on the side bar. To return to the
main view, click the button MAIN.

2.3.1 Signal path

Figure 3 shows a block diagram of the path
a signal takes through the DSM-26/48LAN.
Starting at the inputs, the signals, after
analog/digital conversion (alternatively, the
signal of the digital input AES/EBU can be
selected in the inputs A and B), pass the
input amplifier (GAIN), a high pass filter
(HPF), a low pass filter (LPF), the 10-band
sound adjustment (PEQ), the signal delay
(DELAY), a dynamic range compressor
(COMPRESSOR) and the level limiter
(LIMITER). For each of the output
channels, a mixed signal can be created
from the inputs signals processed. This
mixed signal will pass a high pass filter
(HPF), a low pass filter (LPF), a 10-band
sound adjustment (PEQ), a signal delay
(DELAY), a dynamic range compres-
sor (COMPRESSOR), a level limiter
(LIMITER), the phase inversion option
(PHASE INVERT), the digital/analog con-
version and will then be routed to the
outputs.

The parameters for the blocks shown
can be set in the views MAIN, X-OVER,
IN 1-2/4 and OUT 1-6/8. Some of the
parameters can be accessed via various
views.

% 1MG DSM-26L4N (B8: 96:74:01:22:E3) (Development Mode)

DSP CONTROLLER

LOCAL PRESETS
[ siore |

UNIT PRESETS E

Load

10: My Stereo 3-W L

LINK

Load

IMG DSM-26LAH (B8:96

UNIT NAME
IMG DSM-26LAH

a2 2

48 =

Ll

LINK ®
[ 0.00 | 0.00 | Mute | Mute | 0.00 | 0.00 | 989 | 0.89 | 345 | 3.45 |

MUTE— &

Note: The setting options available depend on the
access rights of the current access level (1= chap-
ter 1). To be able to make all settings, go to the
access level “Development” when calling up the
control program for the first time. This level allows
you to define the access rights and passwords for
the other access levels as required by the users
who will operate the unit (1= chapter 2.3.7).

[N]

@ 1@ 44 @

2 T 2 2 2 2 2 T 2

@t (R ] |- [ltow|Rrow]itud [Ria |LHigh]R bigh]

(8 View MAIN
2.3.2 View MAIN (fig. 8)
H Buttons to go to a different view

K LOCAL PRESETS
To save (“Store”) the current settings as
presets on the computer (like the menu
item “File » Save”) and to load them from
the computer (like the menu item “File
» Open”).

H UNIT PRESETS
To save (“Store”) the current settings as
presets on the unit and to load a preset
that is saved on the unit
Select the storage location from the list
field and enter a name in the upper field.

B LINK — connection status
Green = connected
Red = not connected
To change to a different unit, select the
unit from the list.

B UNIT NAME — name of the unit; over-
write the name to change it

B Control GAIN to adjust the volume of the
inputs; the level indicators are next to
the control; the input/indication fields for
the gain value are beneath the control

Control GAIN to adjust the volume of the
outputs; the level indicators are next to
the control; the input/indication fields for
the gain value are beneath the control

B Switch LINK to link the inputs (in pairs)
B Switch LINK to link the outputs (in pairs)

Switch MUTE to mute the correspond-
ing input or output

Input fields to name the inputs and out-
puts

2.3.3 View IN 1-2/4 (fig. 9)
8 Buttons to go to a different view

B Curve diagram of the magnitude fre-
quency response
Each of the 10 parametric filters has a
point of reference (small square with fil-
ter number) and a frequency curve in a
specific colour. The frequency response
resulting from all active filters is repre-
sented by a white curve.

Some of the filter parameters can also
be set graphically. To do so, move the
corresponding point of reference with
the mouse:

—move horizontally to change the fre-
quency

— move vertically to change the gain

— move horizontally with the right mouse
button to change the quality factor/
bandwidth

— double-click a point of reference to
switch the corresponding filter on or off

@ to show/hide the values of all active
filters

Q, to switch the fine-adjustment mode
on and off

™ to enlarge the display = full-screen
mode; % to return to the reduced
size mode

B to save curves as image files (PNG)

[ Control GAIN to adjust the volume of the
corresponding input; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as @)



[H Switches ON to activate/deactivate the
corresponding filter

A List field TYPE to select the filter type

Input/Indication field FREQ for the filter
frequency (enter values in Hz)

[ Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and
bandwidth)

[ Input/Indication field GAIN for filter
boost/attenuation

Hl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz, “Off” < 20 Hz)

Bl High pass filter HPF: list field to select
the filter type

B3 Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off’ > 20 kHz)

B Low pass filter LPF: list field to select the
filter type

B Switch MUTE to mute the correspond-
ing input (same effect as M)

2.3.4 View OUT 1-6/8 (fig. 10)
E Buttons to go to a different view

Hl Controls MIXER to adjust the mixed sig-
nal from the input channels for this out-
put; the level indicators are next to the
controls; the input/indication fields for
the gain value are beneath the controls

Bl Curve diagram of the magnitude fre-
quency response
(description 1= chapter 2.3.3, H)

B Control GAIN to adjust the volume of the
corresponding output; the level indicator
is next to the control; the input/indication
field for the gain value is beneath the
control (same effect as H)

B8 Switches ON to activate/deactivate the
corresponding filter

E List field TYPE to select the filter type

B8 Input/Indication field FREQ for the filter
frequency (enter values in Hz)

E Input/Indication field Q/BW for the qual-
ity factor/bandwidth (click Q or BW to
change between quality factor and
bandwidth)

Input/Indication field GAIN for filter
boost/attenuation

B High pass filter HPF: input/indication
field for the cut-off frequency (enter val-
ues in Hz, “Off” < 20 Hz)

B High pass filter HPF: list field to select
the filter type

% |MG DSM-26LAN (B8:96:74:01:22:E3) (Development Mode)

File Hardware Preset  Help

L]

640Hz

1.22kHz

2,56kHz L

umiren [25 7]

§.12kHz

.V

Linkwitz-Riley 2408+ &3

10.9 kHz
oo |

Linkwitz-Riley 24dB +

(9)View IN 1

EH Button COMPRESSOR to call up the
configuration window for the compres-
sor of the corresponding input (i chap-
ter 2.3.6)

M Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding input; select the
measuring unit from the list field: time or

2 MG DSM-26LAN (BB:96:74:01:22:E3) (Development Mode)

File Hardware Preset Help

LT LR AARNALIAAR}

[ 000 [ute [ Mutc | e [RMIS

PEQ .
ouT1 | on TYPE FREQ oN
.8 37

distance (for automatic calculation of the
sound delay time)

Level limiter LIMITER: rotary knob THR
with input/indication field for the thresh-
old value

8 Level limiter LIMITER: rotary knob REL
with input/indication field for the release
time

15
50 100 200\ 500 1k 2k 5k 10k 20k

nZ
MUTE o

TYPE FREQ q GAIN
640Hz

e 5] @

1.28kHz

2.56kHz LW

umm
5.12kHz | 14 ! »- .

2
2
2
2
2

10.2 kHz
m

HPF LF F
THR REL
20Hz Linkwitz-| Rlley 24dB v 150Hz But(erwurlh 18dB

10) View OUT 1

M Low pass filter LPF: input/indication field
for the cut-off frequency (enter values in
Hz, “Off” > 20 kHz)

[ Low pass filter LPF: list field to select the
filter type

¥ Switch MUTE to mute the correspond-
ing output (same effect as M)

[ Switch INVERT for phase inversion

@ Button COMPRESSOR to call up the
configuration window for the com-
pressor of the corresponding output
(e chapter 2.3.6)

[H Rotary knob DELAY with input/indica-
tion field for adjusting the signal delay of
the corresponding output; select the
measuring unit from the list field: time or
distance (for automatic calculation of the
sound delay time)

M Level limiter LIMITER: rotary knob THR
with input/indication field for the thresh-
old value

Level limiter LIMITER: rotary knob REL
with input/indication field for the release
time
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2.3.5 View X-OVER (fig. 11)
[ Buttons to go to a different view
[ Curve diagram of the magnitude fre-

9 IMG DSM-26LAN (B8:96:74:01:22:E3) (Development Mode)

File Hardware Preset  Help

quency response for all high pass filters
and all low pass filters of the outputs
When a crossover network is created,
all outputs are represented in a diagram
so that the frequency crossovers are . “ @ @
easy to identify. (For linked outputs, only MUTE
one filter curve is shown.) 7 EONONCNCRCNC
The cut-off frequencies of the filters "’;‘"";" YO
are represented by triangular markings o
above the curve. To change the fre- 5 3
quency, move the corresponding mark- 1504z 150Hz 3.22kHz 3.22kHz
ing with the mouse (as an alternative to
the numeric input in BI/E1).

Bl High pass filter HPF: input/indication
field for the cut-off frequency (enter val-

But 13dB v But 1§dB v Bes12dB v Bes12dB v

3.22kHz 3.22kHz Off Off

Bes 12dB v Bes12dB v

-9.39dB -9.89dB

0.0ms 0.0ms

14

ues in Hz; “Off’ < 20 Hz)
(same effect as HI)

High pass filter HPF: list field to select
the filter type (same effect as Hl)

B Low pass filter LPF: input/indication field
for the cut-off frequency (enter values
in Hz, “Off” > 20 kHz) (same effect as M)

B Low pass filter LPF: list field to select the
filter type (same effect as M)

2.3.6 Window COMPRESSOR

B[(=1[ES

2% IMG DSM-26LAN (B8:96...

File  Hardware Help

COMPRESS0OR

Preset
lso] BACK |
VU [o1] GR

Threshold 24dBu AR

]
[S0ms
o

Release

Ratio -

Makeup Gain

(12) Compressor configuration window

(i) View X-OVER

B Input/Indication field G (gain) for adjust-
ing the volume of the output (same
effect as F and B)

Input/indication field D (delay) for ad-
justing the signal delay of the output
(same effect as [H)

H Level indicators for the outputs

[ Button BACK to return to the previous
view

Level indicator VU and gain reduction
GR

& Rotary knob “Threshold” with input/indi-
cation field for the threshold value

@ Rotary knob “Attack” with input/indica-
tion field for the attack time

[ Rotary knob “Hold” with input/indication
field for the hold time

@ Rotary knob “Release” with input/indica-
tion field for the release time

[ Rotary knob “Ratio” with input/indication
field for the compression ratio

Rotary knob “Makeup Gain” with input/
indication field for level loss compensa-
tion

Switch LINK to link the outputs (in pairs,
same effect as Bl)

Switch MUTE to mute the correspond-
ing output (same effect as M)

B Switch PHASE INVERT for phase inver-
sion of the corresponding output (same
effect as M)



2.3.7 Managing access rights

2.3.7.1 Entering passwords

When the unit is switched on, the access
level “User” will usually be selected
(i chapter 1). To go to a higher access
level, call up the menu item “Hardware
» Enter Password” and enter the password.

2.3.7.2 Changing passwords

To change the password in the current
access level, or, in the level “Develop-
ment”, to change the passwords for a lower
access level, call up the menu item “Hard-
ware BConfigure #Change Password”
or “Hardware #»Passwords »User/Admin/
Developer Password”.

To change the password of the current
level, first enter the current password, then
enter the new password, and finally re-
enter the new password to confirm it. Pass-
words for lower access levels can be
directly entered and will also be displayed.

In the level “Development”, individual
presets can be saved with separate pass-
words. Prior to saving a preset, make the
desired settings via the menus “Preset
» Passwords B®Admin Password” and
“... » Developer Password”.

Important: Passwords saved with the pre-
set will take precedence over system pass-
words. When a preset is called up which
has been saved with individual passwords
for the access levels “Administrator” and
“Development”, the system passwords for
these levels will be invalid.

2.3.7.3 Changing access rights
Via the menu branch “Hardware » Config-
ure # Access Rights”, the access rights for
lower access levels can be defined. The
table (fig. 13) shows the options and fac-
tory-set values for the individual levels.
Particular rules apply concerning the
access to the settings of the input parame-
ters and output parameters. The access
rights for these settings (Access Input/
Output Channel) are exclusively saved on
the level “Development” (together with the
corresponding preset). Prior to saving a
preset, make the settings desired via the
corresponding menu “Preset B Access
Rights # Locked Access Rights”, “... # User
Access Rights” and “... » Admin Access
Rights”.

2.3.8 Locked State

Call up the menu item “Hardware »Lock
Unit” to go to the lowest access level
“Locked State”. A message will appear to
inform you that you can exit this level only
by entering the password of a higher level.
Click “OK” to confirm this message.

2.3.9 Standby

Call up the menu item “Hardware » Go to
Standby” to set the unit to the standby
mode. To return to the normal mode,
call up the menu item “Hardware »Exit
Standby” (see chapter 2.2).

2.3.10 Defining the switch-on preset
Call up the menu item “Hardware » Config-
ure # Power On Preset” to define the set-

tings that shall apply when the unit is
switched on.

In the list field of the window displayed,
select the preset that is to be automatically
loaded each time the unit is switched on, or
select the option “Last Setting” if the unit is
to use the settings most recently made
before the unit was switched off.

2.3.11 Saving/Restoring all presets
Call up the menu item “File #»Backup
Presets” to save all presets of the unit on
the computer and then select the storage
location (folder).

To restore the saved presets, call up
the menu item “File » Restore Presets”.

3 Control via
a Tablet Computer

In addition to the supplied control program
for PCs, a control program named “DSP-
CONTROL” for tablet computers is avail-
able in the “App Store” of Apple Inc.

Subject to technical modification.

Access Rights Access Levels
Development Administrator User Locked State

Load Presets v | 7} O
Save Presets v ) %} O
Load Factory File v v
Create Factory File v
Enable Display Lock Control 4 %} %}
Change User Access Rights v |
Change Locked Access Rights v %} [}
Change Unit Name v ) M O
Lock Automatically After Power Cycle O O
Change Unit Configuration
(Netw%rk, AutoStar?dby, Startup Preset) Y & & =
Load an Empty Preset v | | O
Upgrade the Unit Firmware v 7} O O
Access Input Channel 4 O O O
Access Output Channel v | | O

@Available access rights and their factory-set values

All rights reserved by MONACOR® INTERNATIONAL GmbH & Co. KG. No part of this instruction

manual may be reproduced in any form or by any means for any commercial use.
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Benutzerhandbuch DSM-26LAN / DSM-48LAN

EinfUhrung

Herzlichen Glickwunsch zum Kauf des DSM-26/-48LAN. IMG Stage Line bietet lhnen die beste
High-End-Digital-Audio-Verarbeitung. Nachdem Sie sich mit dem Gerat vertraut gemacht haben, empfehlen
wir lhnen zu experimentieren. Finden Sie den effektivsten und effizientesten Weg fir Ihr System durch die
Nutzung des leistungsstarken DSM-26/-48LAN.

Der DSM-26/-48LAN ist ein leistungsfahiges Lautsprechermanagement-System mit 2/4 analogen Eingangen,
2 AES / EBU-Eingangen, 6/8 Ausgangen, 10 PEQ Bandern pro Eingang und Ausgang und einem Frequenz-
bereich bis zu 40 kHz.

Die robuste analoge Eingangsstufe akzeptiert Eingangsspannungen von bis zu + 23dBu praktisch flr jede
beliebige Quelle auf dem Markt und mit einem ausgezeichneten Dynamikbereich 118 dB.

Der DSM-26/-48LAN ist ausgestattet mit einer 64-Bit-Digital-Verarbeitung und einem der besten Wandler,
die auf dem Markt zu finden sind und bietet eine Klangqualitat, die mit Referenz-Geraten konkurieren kann.

Dieses Handbuch beschreibt, wie mit Hilfe der Bedienelemente an der Vorderseite des Gerates an dem
DSM-26/48LAN Einstellungen vorgenommen werden kdnnen. Alternativ kann der DSM-26/48LAN komplett
Uber eine Remote-Verbindung zu einem PC oder MAC konfiguriert werden.

Bitte beachten Sie die Details im Software-Handbuch fir die Fernbedienungs-Anwendung.

Uber die Vorderseite oder Uber das Software-Programm werden die DSP-Einstellungen und resultierende
Parameter im Moment der Veranderung der Parameter berechnet. Frequenzen kénnen mit 1 Hz, Delay-
Funktionen mit Mikrosekunden und Lautstarken mit 0,01 dB Genauigkeit eingestellt werden.

Beim Verandern von Werten Uber die Frontbedienelemente, sind einige Werte in der Feinabstimmung
beschrankt, so wird die Verstarkung z.B. in 0,25 dB Schritten eingestellt.

Eigenschaften:

- 118dB Dynamik Umfand im Eingang / 114dB Dynamik Umfang im Ausgang
- Symmetrierte Eingange
- Symmetrierte Ausgange
- Frequenzbereich 20Hz....40kHz
- Zehn vollparametrische Filter im Input und Output
- EQs mit folgenden Filtertypen:
Bell, High Shelf, Low Shelf, Notch, Allpass, Band Pass, High Pass, Low Pass
- 1000ms Delay im Eingang, 20ms Delay im Ausgang (DSM-26LAN)
- 2000ms Delay im Eingang, 2000ms Delay im Ausgang (DSM-48LAN)
- Butterworth, Bessel, Linkwitz-Riley Filter bis zu 24dB/Oktave.
- True RMS Compressor
- Sehr schneller Peak Limiter
- Latenzzeit: 660 Mikrosekunden
- Volle Steuerung und Echtzeit Monitoring via PC oder MAC (USB and Ethernet interface)
- Integriertes 16stelliges LCD Display
- 80 Presets
- 64 Bit Multimode Digital Processing
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Benutzerhandbuch DSM-26LAN / DSM-48LAN

Sicherheitshinweise

WARNUNG! Zu lhrem Schutz beachten Sie bitte Folgendes: Das Gerat darf weder Tropf- oder Spritzwasser
noch einer Flussigkeit ausgesetzt werden. Es dirfen keine Objekte, die Flissigkeiten enthalten, wie z.B. Vasen,
auf das Gerat gestellt werden. Wenn Flussigkeit auf dem Gerat verschittet wird, schalten Sie es bitte sofort aus,
ziehen den Netzstecker von der Stromquelle ab und bringen Sie es zu lhrem Fachhandler

REINIGUNG DES GERATES: Reinigen Sie das Gerat nur mit einem trockenen Tuch und blockieren Sie
keine Bellftungsoffnungen.

Installieren Sie das Gerat nach den Anweisungen des Herstellers. Platzieren Sie das Gerat nicht in der Nahe
von Warmequellen wie Heizkdrpern, Warmespeichern, Ofen oder anderen Geraten (einschlieRlich
Verstarkern), die Warme erzeugen.

Verwenden Sie nur vom Hersteller freigegebene Zusatzgerate bzw. Zubehoér. Trennen Sie das Gerat
wahrend eines Gewitters oder bei langerem Nichtgebrauch vom Stromnetz.

Umgehen Sie nicht die Sicherheitsfunktion des gepolten und geerdeten Steckers. Ein gepolter Stecker darf
niemals mit Gewalt in eine Steckdose oder in das Gerat eingesteckt werden. Beachten Sie die Kodierung der
Steckerform.

Wenn der mitgelieferte Stecker nicht in Ihre Steckdose passt, wenden Sie sich bitte an eine Fachkraft fiir
Elektrotechnik, um eine veraltete Steckdose auszutauschen.

Ein Netzstecker, der durchtrennt oder verformt ist, ist unsicher. Entsorgen Sie den Netzstecker bei einer
geeigneten Einrichtung. Unter keinen Umstanden sollten Sie ein beschadigtes oder durchtrenntes Netzkabel
in eine Steckdose einstecken.

Schutzen Sie das Netzkabel so, dass es vor Tritten geschutzt ist, insbesondere an Steckverbindungen.
Verwenden Sie nur die Ablagen, Stative oder Tische, die vom Hersteller angegeben sind oder mit dem Gerat
gekauft wurden.

Wenn Sie eine Ablage benutzen, seien Sie vorsichtig beim Bewegen des Standers/der Gerate-Kombination,
um Verletzungen durch Umkippen zu vermeiden.

Lassen Sie alle Wartungsarbeiten nur von qualifiziertem Service-Personal durchfihren.

Eine Wartung ist erforderlich, wenn das Gerat in irgendeiner Weise beschadigt wurde, wie z.B. das
Stromkabel oder der Stecker, wenn Flissigkeit oder Gegenstande in das Gerat gelangt sind,

das Gerat Regen oder Feuchtigkeit ausgesetzt wurde, nicht normal funktioniert oder fallen gelassen wurde.
EIN-/AUSSCHALTER: Wenn das Gerat einen Ein-/Ausschalter besitzt, wird der Ein-/Ausschalter an diesem
Gerat verwendet, unterbrechen Sie nicht die Verbindung zum Netz.

VOM NETZ TRENNEN: Der Stecker sollte immer leicht zu ziehen sein. In Racks oder Anlagen, in denen der
Stecker nicht zuganglich ist, sollte ein all-Poliger Hauptschalter mit einem Kontaktabstand von mindestens
3mm eingebaut werden.

FUR PRODUKTE MIT EXTERN ZUGANGLICHEM SICHERUNGSFACH:

Ersetzen Sie die Sicherung durch eine des gleichen Typs und Nennwerts.

WARNUNG: DIESES GERAT MUSS AN EINER NETZSTECKDOSE MIT SCHUTZLEITER
ANGESCHLOSSEN WERDEN.

Die Adern im Netzkabel sind in Ubereinstimmung mit dem folgenden Code gefarbt:

Schutzleiter/Erde: GRUN und GELB

Neutralleiter: BLAU

Phase: BRAUN

Die Farben der Adern im Netzkabel dieses Gerates, kdnnen moéglicherweise nicht mit den Farbmarkierungen
der Klemmen in dem Stecker Uibereinstimmen. In diesem Fall ist wie folgt vorzugehen:

Die Ader, welche griin und gelb gefarbt ist, muss an die Klemme im Stecker mit dem Buchstaben E, oder mit
dem Symbol fir Erde oder griin, oder griin und gelb angeschlossen werden.

Die blaue Ader muss an der Klemme N, schwarz oder blau angeschlossen werden. Die braune Ader muss an
der Klemme L, rot oder braun angeschlossen werden. Dieses Gerat kann mit einem anderen Netzkabel,
Netzstecker oder beidem, je nach verfligbarer Stromquelle installiert werden.

Wenn der Netzstecker ausgetauscht werden muss, Uberlassen Sie die Wartung qualifiziertem Fachpersonal.
Die grin / gelbe Ader sollte direkt mit dem Gehduse verbunden werden.

WARNUNG: Wenn der Schutzleiter/Erdung unterbrochen oder beschadigt ist, werden bestimme
Fehlermeldungen im System angegeben, an das es angeschlossen ist und kénnen die volle Netzspannung
zwischen Gehause und Erde fuhren.

Wenn Sie dann das Gehause und einen geerdeten Gegenstand anfassen, kann es zu schweren Verletzungen
oder sogar zum Tod kommen.

Im Inneren des Gerates herrschen gefahrliche Spannungen!

Bitte lesen Sie die Bedienungsanleitung aufmerksam durch.

Im Inneren des Gerates befinden sich keine vom Benutzer zu wartenden Teile.

Offnen Sie das Gerat nicht.
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Versuchen Sie nicht, Wartungen am Prozessor selbst durchzufiihren.

Uberlassen Sie alle Wartungsarbeiten qualifiziertem Personal.

Verbinden Sie dieses Gerat nur mit Stromquellen, die an der Rickseite des Gerats angegeben sind. Um die
Gefahr eines Brandes oder Stromschlags zu verringern, wenden Sie sich an qualifiziertes Servicepersonal
oder einen Elektriker. Wenn das Gerat mit einer Versorgungsspannung bis 240V verbunden ist, verwenden
Sie ein zugelassenes Stromkabel, dass den Normen nach CSA / UL und VDE entspricht.

Offnen Sie das Gehause aus irgendeinem Grund, erlischt die Garantie des Herstellers.
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1.Uberblick Giber Anschliisse und Bedienung

Zusatzlich zu den verfigbaren Funktionen, wie in dieser Bedienungsanleitung beschrieben, haben Sie auch
die Moglichkeit, die Steuerung des DSM mit einem PC oder MAC Uber das Netzwerk oder USB auszufiihren.
Bitte beachten Sie die Details im Software-Handbuch.

1.1.Vorderseite

1.1.1.USB Anschluss

Der USB Anschluss wird verwendet um den DSM-26/-48LAN mit einem PC oder MAC zu verbinden. Das Gerat
kann danach in Echtzeit mit dem frei erhaltlichen PC und MAC Konfigurationsprogramm konfiguriert und
kontrolliert werden. Aul3erdem kénnen Sie mit diesem Programm ihr DSP auf den neusten Stand der

Firmware updaten. Bitte besuchen Sie regelmallig unsere Website flr neue Updates.

1.1.2.Input VU Meters

Es sind vier unabhangige Input Meter verfugbar. Die LEDs zeigen: Signal (-48dBu), -6dBu, Limit und Clip.
Die Angabe bezieht sich auf den absoluten Input Level, multipliziert mit der Eingangsverstarkung. Die Limit
LED leuchtet, wenn eine Limiter-Grenze im Kanal Gberschritten wird. Die CLIP LED leuchtet, wenn ein Input
Level von +22dBu erreicht ist.

1.1.3.Funktionstasten

Die Funktionstasten erlauben direkten Zugriff auf alle zu bearbeitenden und zu steuernden Funktionen, siehe
entsprechende Abschnitte der detaillierten Beschreibung fur jede dieser Tasten.

1.1.4.Drehregler

Der Drehregler wird verwendet, um durch das Menu zu scrollen und Werte einzustellen. Durch Drehen
werden die Werte verandert und der DSP Prozessor aktualisiert sich in Echtzeit. Ausserdem werden
durch das Driicken dieses Drehreglers unterschiedliche Parameter-Ebenen angewahit.

1.1.5.0utput VU Meters

Es sind sechs unabhangige Output VU-Meter verfigbar. Die LEDs zeigen: Signal (-48dBu), -6dBu, Limit und
Clip. Die Anzeige bezieht sich auf den Output Level nach dem Output Limiter.

Die Limiter LED leuchtet, wenn die Limiter-Schwelle im Kanal tberschritten wird. Die Clip LED leuchtet bei
mehr als 12dB Verstarkung.

1.1.6.0utput Mute Taster

Die sechs Mute-Tasten erméglichen das unabhangige Stummschalten eines jeden Ausgangs.
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1.2.Ruckseite

1.2.1.Netzanschluss

Der DSM-26/-48LAN besitzt ein internes Netzteil, welches Spannungen von 200-240V und Frequenzen von
50Hz-60Hz akzeptiert. Ein Kaltgerate-Kabel ist im Lieferumfang enthalten.

1.2.2.Einschalter

Mit dem Netz-Schalter kann der DSM-26/-48LAN an- und ausschaltet werden. Hinweis: Wir empfehlen, den
Controller vorher mit dem Verstarker zu verbinden und einzuschalten, bevor Sie den Verstarker einschalten.

1.2.3.Ethernet Anschluss

Die RJ-45 Anschlisse verbinden ihr Produkt mit dem Netzwerk. Mit dem frei erhaltlichen PC und MAC
Konfigurationsprogramm konfigurieren und steuern Sie in Echtzeit den Controller . Mit diesem
Programm koénnen Sie aullerdem den Controller auf den neuesten Stand der Firmware bringen. Bitte
besuchen Sie regelmalig unsere Website und installieren Sie neue Updates.

1.2.4.Analoge Eingange

Die Eingangs-Sektion des DSM-26/-48LAN bietet 2/4 symmetrierte XLR Anschlusse.
Der Input Level betragt +23dBu max (11V eff.).

1.2.5.Analoge Ausgange

Die Ausgangs-Sektion des DSM-26/-48LAN bietet 6/8 elektronisch symmetrierte XLR Anschlisse.
Der Output Level betragt +12dBu max (4V eff.).

1.2.6.AES/EBU Eingang

Der digitale Eingang des DSM-26/-48LAN bietet zwei Input Kanale (Stereo) an einem symmetrischen XLR-
Anschluss. Der Prozessor akzeptiert AES/EBU-Signale (symmetrisch) und S/PDIF-Signale (asymmetrisch)
mit 16 bis 24 Bit Aufldsung und 44.1, 48, 88.2 oder 96kHz Sample-Frequenz.
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2.Einstieg

2.1.Schnellstart

Fir diejenigen von lhnen, die direkt einsteigen wollen, sind zur Optimierung der Leistung ihres Gerates
die folgenden Informationen vorgesehen.

2.2.Anschlusse

2.2.1.Signal Anschlusse

Wenn Sie ihren Controller einrichten, stellen Sie die Anschlusse wie folgt her:
- Als erstes alle Anschllisse an dem Controller anschlieen und dann einschalten.
- Verbinden Sie die Ausgange des Mixers mit dem CH1 XLR Eingangs-Anschluss (Mono) oder beiden
CH1 und CH2 XLR Eingangs-Anschlissen (Stereo) des Controllers.
- Verbinden Sie die Ausgangsbuchsen des DSM mit den Eingangsbuchsen des Verstarkers.
Stellen Sie sicher, dass die Verstarker die LETZTEN Geréate sind, die ein- und die ERSTEN, die ausgeschaltet
werden. Wenn alles angeschlossen und der Controller eingeschaltet ist, konnen alle verfligbaren Funktionen
im Signalweg mit den Bedienelementen auf der Vorderseite eingestellt und via LC-Display angezeigt werden.

2.2.2.Fernuberwachung und Steuerung

Far schnelle und optimale Einstellungen empfehlen wir, die frei erhaltliche Konfigurationssoftware fur PC
oder MAC zu installieren und zu nutzen. Sie bietet ein komplettes und umfassendes Werkzeug fur die
Konfigurierungseinstellungen ihrer Lautsprecher und um voreingestellte Werte zu verwalten und zu
speichern.

SchlieRen Sie das Gerat an einem USB-Anschluss oder USB-Hub ihres Computers an (USB 1.0 oder hoher).
Wenn Sie Probleme mit dem USB-Anschluss haben, lesen Sie die Installationshilfe, um den richtigen Treiber
zu installieren.

Wenn Sie das Geréat via Ethernet Netzwerk angeschlossen haben, haben Sie mehrere Optionen. Die PC/MAC
Anwendung hat ein auto-discovery-tool, welches sich automatisch mit jedem gefundenen Gerat im Netzwerk
verbindet.

Bitte beachten Sie die Details im Software-Handbuch der Steuerungs-Software.

2.2.2.1.Standard DHCP Network

Fir die einfachste Verbindung verwenden Sie einen Standard-Ethernet-Router. Sobald Sie den Stecker in
das Gerat und Ihren Computer eingesteckt haben, sollte die Verbindung automatisch erfolgen.
Standard-Router haben einen DHCP-Server eingebaut. Ein DHCP-Server vergibt eine Netzadresse auf Ihrem
Computer und dem DSM-26/-48LAN automatisch, sobald Sie eine Verbindung hergestellt haben.

2.2.2.2 Verbindung ohne DHCP Server

Alternativ kdnnen Sie einen simplen Ethernet Switch benutzen, um das Gerat mit dem PC oder MAC zu
verbinden. Bitte beachten Sie, das es insbesondere bei Windows Computern einige Minuten dauern kann,

bis eine Adresse zugewiesen wird (Windows-Meldung: "Die Verbindung hat nur begrenzte oder keine
Konnektivitat"). Der Computer und der DSM-26/-48LAN werden sich beide selbst eine Netzwerkadresse in dem
Zero Config Bereich (169.254.0.0 - 169.254.255.255) zuweisen und der DSM-26/-48LAN wird von der PC/MAC
Anwendung automatisch erkannt. Um die Verbindung ohne DHCP Router zu erleichtern, ist es am einfachsten,
eine IP-Adresse fur den Computer festzulegen.

Wahlen Sie dazu bitte eine Adresse aus dem Zero Config Bereich und geben unter Subnetzmaske:
255.255.0.0. ein.
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2.2.2.3.Festgelegte IP-Adresse

Es ist auch moglich eine IP-Adresse und Subnetzmaske fiir den DSM-26/-48LAN festzulegen.

Warnung: Wenn Sie eine falsche Adresse in ihrem Computer setzen, wird es ihnen nicht mehr maoglich sein
sich zu verbinden. Wenden Sie sich an einen Systemadministrator bevor S ie solche Einstellungen
vornehmen.

2.2.2.4 Firewall

Nachdem Sie die Software Anwendung das erste Mal gestartet haben, wird ihr Computer eventuell fragen ob
die Anwendung auf das Netzwerk zugreifen darf oder nicht. Bitte stellen Sie sicher, dies zu erlauben. Wenn
sich eine Firewall zwischen der Anwendung und dem DSM-26/-48LAN befindet, wird die Anwendung eventuell
den DSM-26/-48LAN nicht finden.

2.3.System Setup und Gain-Struktur

Dieses Produkt bietet eine breite Palette von Werkzeugen fiir das Sound-Design und dessen Einrichtung. Bei
richtiger Anwendung helfen diese Tools ihrem System, effizienter zu werden und den bestmdglichen Klang
zu erreichen.

Im folgenden Abschnitt wird erlautert, wie Sie die maximale Signalverstarkung und die Limiter verwenden, um
den Verstarker vor Ubersteuerung zu schiitzen.

Bei einem traditionellen System-Design, wirde das Signal einen System-EQ, einen Kompressor und

eine Frequenzweiche mit Ausgangspegel-Kontrolle durchlaufen. Durch Einsatz zusatzlicher Filter kann die
Frequenzweiche das Verhalten der Lautsprecher verbessern und nur bestimmte Frequenzbereiche
freigeben. Der Limiter dient dazu, ihren Verstarker und ihre Lautsprecher vor Ubersteuerung zu schutzen.
Ihr Verstarker spielt eine wichtige Rolle im System-Setup, weil er das letzte Element in der Kette vor dem
Lautsprecher ist. Wenn |hr Limiter und Ihr Verstarker falsch eingestellt sind, leistet ihr System nicht die volle
mdgliche Leistung oder die Lautsprecher kdnnen beschadigt werden.

Um den Controller optimal auszusteuern, gehen Sie wie folgt vor: Speisen Sie den Controller mit einem
Normianlpegel vom Mischpult und stellen den Input Fader auf Odb.

Stellen Sie die Frequenzweichen, die Sie verwenden mdchten ein, und stellen ebenfalls den Output Fader
auf Odb.

Die Verstarker stellen Sie auf volle Ausgangsleistung, die Lautsprecher dirfen jedoch noch nicht mit dem
Verstarker verbunden sein. Jetzt reduzieren Sie den Ausgangspegel vom DSM und stellen die
Limiter-Parameter ein, um die gewilnschte Verstarkung zu erlangen. Der Limiter sollte den Verstarker so
begrenzen, dass der Verstarker nicht Ubersteuert. Jetzt drehen Sie die Lautstérke der Verstarker auf Null,
schliel3en Sie lhre Lautsprecher an und erhéhen Sie langsam die Lautstarke des Verstarkers. Uberprufen Sie
stets den Sound der Lautsprecher-Systeme.

Die Ausgangsleistung des Verstarkers sollte passend zu ihrem Laussprecher-System ausgewahlt oder
begrenzt werden.

Nach erfolgreicher Einstellung, sollte ein verzerrungsfreier Klang zu héren sein und die Limiter-LEDs blinken
oder sind aus. Wenn diese kontinuierlich blinken oder sogar leuchten, ist der Ausgangspegel Uberschritten
und die Einstellung ist nicht optimal. Reduzieren Sie dann den Ausgangspegel lhres Controllers.

Wenn das Eingangssignal zu schwach ist, erhéhen Sie die Lautstarke am Mischpult oder am
Eingangangsverstarker des DSM.
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3.Aufbau und Betrieb

Installieren Sie das Gerat auf einer flachen, stabilen Oberflache, die nicht verbogen oder gekrimmt ist. Bevor
Sie den Controller einschalten, achten Sie darauf, dass die Stromversorgung der Produktspezifikation
entspricht und alle betroffenen Komponenten richtig angeschlossen sind. Schalten Sie die Gerate in der
richtigen Reihenfolge ein, um nicht die Lautsprecher-Systeme zu beschadigen oder ungewollte lautstarke
Impulse abzugeben, die eventuell gesundheitsschadlich sein kdnnten.

3.1.System Uberpriifung

Nach dem Anschluss aller Kabel sollten Sie alle Ausgadnge stumm schalten oder den Gain-Level

des Verstarkers auf minimum drehen. Stellen Sie sicher, dass die richtigen Ausgange des Controllers an die
passenden Eingange des Verstarkers angeschlossen sind, die zu den verschiedenen Lautsprecher
Systemen flhren. Die falschen HF Signale kénnten die Basslautsprecher beschadigen, genauso wie LF
Signale die Hochtonlautsprecher schadigen! Aktivieren Sie die HF-Ausgange als Erstes.

Es ist ratsam, einen grofen Kondensator in Reihe mit dem HF-Treiber (47 bis 100 uF)zu installieren. Auf
diese Weise werden die Treiber etwas gegen zuféallige Messgeratefehler geschuitzt.

3.2.Input Setup

Driicken Sie die Channel-Up- oder -Down-Taste, um den Eingangskanal zu bearbeiten. Schalten Sie dazu
vorher die Ausgange auf stumm oder den Ausgangs-Fader auf einen niedrigen Wert.
Um durch die verschiedenen Elemente zu wechseln, driicken Sie die Position Up- bzw. Down-Taste.

3.2.1.Gain

Stellen Sie die Verstarkung/Gain durch drehen des Drehreglers ein. Die Verstarkung wird in Schritten von
0,25 dB eingestellt. Kleinere Schritte (0,01 dB) kédnnen Uber die PC- oder MAC-Software eingestellt werden.

3.2.2.Input Auswahl
Wahlen Sie die Eingangs-Quelle (Analog oder AES / EBU) durch Drehen des Drehreglers.

3.2.3.Delay

Stellen Sie die Verzoégerungszeit durch Drehen des Drehreglers ein. Wahlen Sie die angezeigte Einheit (ms
oder s, mm oder m, Feet/Ful}, Inch/Zoll oder Mil) durch Dricken des Drehreglers aus.

3.2.4.Tiefpassfilter LPF

Stellen Sie die Low-Pass-Filter Frequenz durch Drehen des Drehreglers ein. Durch Drehen des Drehreglers
im Uhrzeigersinn kénnen Sie die Frequenz bis 20kHz einstellen.

Durch Driicken des Drehreglers andern Sie die Filtertypen. Sie kbnnen wahlen zwischen: Butterworth 6dB,
Bessel 6dB, Butterworth 12dB, Bessel 12dB Linkwitz Riley 12dB, Butterworth 18dB, Bessel 18dB,
Butterworth 24dB und Bessel 24dB. Wenn Sie Filter hdherer Ordnung haben mdchten, dann benutzen Sie
zusatzlich die PEQ Blocke (siehe unten).
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3.2.5.Hochpassfilter HPF

Stellen Sie die High-Pass-Filter Frequenz durch Drehen des Drehreglers ein. Durch Drehen des Drehreglers
gegen den Uhrzeigersinn kdnnen Sie die Frequenz bis 20Hz einstellen.

Durch Dricken des Drehreglers andern Sie die Filtertypen. Sie kénnen wahlen zwischen: Butterworth 6dB,
Bessel 6dB, Butterworth 12dB, Bessel 12dB Linkwitz Riley 12dB, Butterworth 18dB, Bessel 18dB,
Butterworth 24dB und Bessel 24dB. Wenn Sie Filter héherer Ordnung haben méchten, dann benutzen Sie
zusatzlich die PEQ Blocke (siehe unten).

3.2.6.Parametrischer Equalizer PEQ

Es gibt zehn voll parametrische EQs. Jedes Band kann frei Uber den gesamten Frequenzbereich von 20Hz
bis 20kHz eingestellt werden. Stellen Sie die Frequenz oder anderer Parameter durch Drehen des
Drehreglers ein.

Durch Driicken des Drehreglers andern Sie die Filter-Parameter. Die verfligbaren Parameter sind: Frequenz
(20Hz bis 20kHz), Gain (-12dB bis +12 dB), Q (0,2 bis 25), Aktiviert (On oder Off), Typ (Glocke, High Shelf,
Low Shelf, Notch, All Pass, Band Pass, High Pass, Low Pass). Der Q-Wert stellt die Steilheit des Filters in
dB/Okt ein.

3.2.7.Kompressor

Der Kompressor ist ein echter RMS-Kompressor. Drehen Sie den Drehregler, um z.B. die
Schwelle/Threshold zu bestimmen. Driicken Sie den Drehschalter, um die Parameter zu wahlen. Die
verfugbaren Parameter sind: Threshold, Attack, Hold, Release-Ratio und Gain-Makeup.

3.2.8.Limiter

Der Begrenzer/Limiter ist ein Null-attack Peak-Limiter. Nur der Schwellenwert und Ausschwingzeit/Release
kénnen eingestellt werden. Driicken Sie den Drehregler, um die Parameter zu wahlen. Der Release-Wert
wird in dB pro Sekunde angezeigt.
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3.2.9.Kanale verknupfen

Durch die VerknUpfung/Link von 2 Kanéalen werden die Einstellungen fur beide Kanale identisch verandert,
aufder fur den Mischer und Stummschaltung. Drehen Sie den Drehregler, um die Channel-Link ein- oder
auszuschalten.

r '
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3.3.0utput Setup

Dricken Sie die Channel-Up-oder -Down-Taste, um den Ausgangs-Kanal zu bearbeiten. Schalten Sie dazu
vorher die Ausgange auf stumm oder den Ausgangs-Fader auf einen niedrigen Wert.
Um zwischen den verschiedenen Elementen zu wechseln, driicken Sie die Position Up- bzw. Down-Taste.

3.3.1.Gain

Stellen Sie die Verstarkung/Gain durch Drehen des Drehreglers ein. Die Verstarkung wird in Schritten von
0,25 dB eingestellt. Kleinere Schritte (0,01 dB) kénnen tber die PC- oder MAC-Software eingestellt werden.

3.3.2.Mixer

Drehen Sie den Drehregler, um das Signal vom gewahlten Eingang zu dem ausgewahlten Ausgang zu
mischen. Driicken Sie den Drehschalter, um den Eingang zu wahlen. Achtung: Der Mischer ist nur verfligbar,
wenn die Ausgange nicht durch Channel Link verknlpft sind. Ist der Channel Link aktiv, wird der Mischer
den zweiten verknupften Kanal Gberspringen.

3.3.3.Delay

Stellen Sie die Verzoégerungszeit durch Drehen des Drehreglers ein. Wahlen Sie die angezeigte Einheit (ms
oder s, mm oder m, Feet/Ful3, Inch/Zoll oder Mil) durch Driicken des Drehreglers aus.

3.3.4.Tiefpassfilter LPF

Stellen Sie die Low-Pass-Filter Frequenz durch Drehen des Drehreglers ein. Durch Drehen des Drehreglers
im Uhrzeigersinn kénnen Sie die Frequenz bis 20kHz einstellen.

Durch Driicken des Drehreglers andern Sie die Filtertypen. Sie kbnnen wahlen zwischen: Butterworth 6dB,
Bessel 6dB, Butterworth 12dB, Bessel 12dB Linkwitz Riley 12dB, Butterworth 18dB, Bessel 18dB,
Butterworth 24dB und Bessel 24dB. Wenn Sie Filter héherer Ordnung haben méchten, benutzen Sie
zusatzlich die PEQ Bldcke (siehe unten).
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3.3.5.Hochpassfilter HPF

Stellen Sie die High-Pass-Filter Frequenz durch Drehen des Drehreglers ein. Durch Drehen des Drehreglers
gegen den Uhrzeigersinn kdnnen Sie die Frequenz bis 20Hz einstellen.

Durch Driicken des Drehreglers andern Sie die Filtertypen. Sie kénnen wahlen zwischen: Butterworth 6dB,
Bessel 6dB, Butterworth 12dB, Bessel 12dB Linkwitz Riley 12dB, Butterworth 18dB, Bessel 18dB,
Butterworth 24dB und Bessel 24dB. Wenn Sie Filter hdherer Ordnung haben méchten, benutzen Sie
zusatzlich die PEQ Blocke (siehe unten).

3.3.6.Parametrischer Equalizer PEQ

Es gibt zehn voll parametrische EQs. Jedes Band kann frei Uber den gesamten Frequenzbereich von 20Hz
bis 20kHz eingestellt werden. Stellen Sie die Frequenz oder andere Parameter durch Drehen des
Drehreglers ein.

Durch Dricken des Drehreglers andern Sie die Filter-Parameter. Die verfigbaren Parameter sind: Frequenz
(20Hz bis 20kHz), Gain (-12dB bis +12 dB), Q (0,2 bis 25), Aktiviert (On oder Off), Typ (Glocke, High Shelf,
Low Shelf, Notch, All Pass, Band Pass, High Pass, Low Pass). Der Q-Wert stellt die Steilheit des Filters in
dB/Okt ein.

3.3.7.Kompressor

Der Kompressor ist ein echter RMS-Kompressor. Drehen Sie den Drehregler, um z.B. die
Schwelle/Threshold zu bestimmen. Driicken Sie den Drehschalter, um die Parameter zu wahlen. Die
verfugbaren Parameter sind: Threshold, Attack, Hold, Release-Ratio und Gain-Makeup.

3.3.8.Limiter

Der Begrenzer/Limiter ist ein Null-attack Peak-Limiter. Nur der Schwellenwert und Ausschwingzeit/Release
koénnen eingestellt werden. Dricken Sie den Drehregler, um die Parameter zu wahlen. Der Release-Wert
wird in dB pro Sekunde angezeigt.
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3.3.9.Invertierte Phase

Drehen Sie den Drehregler, um Phasenumkehr ein-oder auszuschalten.

Pig guprey o
Fana® "™l en sales sliss

3.3.10.Kanale verknupfen

Durch die VerknlUpfung/Link von 2 Kanéalen werden die Einstellungen fir beide Kanale identisch verandert,
ausser fur den Mischer und Stummschaltung. Drehen Sie den Drehregler, um die Channel-Link ein- oder
auszuschalten.

3.4.System Menu

Dricken Sie die Menl-Taste, um das System-Menu aufzurufen. Driicken Sie die Menu-Taste, um durch die
Menupunkte zu wechseln. Die verfigbaren Menloptionen sind:

3.4.1.Preset laden

Drehen Sie den Drehregler, um das Preset auszuwahlen, das Sie laden méchten. Driicken Sie den
Drehregler, um "YES" auszuwahlen und bestatigen Sie durch erneutes Driicken. Das Preset wird geladen und
alle Einstellungen werden sofort Gbernommen. Alle Einstellungen, die vor dem Laden eingestellt waren,
werden geldscht. Diese Aktion kann nicht riickgangig gemacht werden.

Die Presets enthalten alle Filter, Dynamik, Gain-Einstellungen usw., mit anderen Worten, alles, was
einstellbar ist. Aber Presets enthalten nicht den Namen des Gerats, Netzwerkkonfiguration, automatische
Standby-Verzégerung, Zugriffsrechte und Kennworter.

3.4.2.Preset speichern

Drehen Sie den Drehschalter, um den Speicherplatz des Presets zu bestimmen. Wenn der Speicherplatz
nicht leer ist, dann wird das vorherige Preset an dieser Stelle (iberschrieben. Diese Aktion kann nicht
rickgangig gemacht werden.

Das System fordert Sie auf, einen Namen fur das Preset einzugeben. Wahlen Sie ein Zeichen mit dem
Cursor des Drehreglers aus. Durch Dricken des Drehreglers wird das von Ihnen ausgewahlte Zeichen bestatigt.
Durch Bewegen des Cursors kdnnen Sie das nachste Zeichen bearbeiten. Durch Driicken der
EXIT/ESC-Taste wird das letzte Zeichen geléscht. Sobald der Name eingegeben ist, driicken Sie die
Menu-Taste. Wenn Sie weitere Presets speichern mdchten, wahlen Sie JA, indem Sie den Drehregler
dricken. Um den Vorgang abzubrechen, driicken Sie die Exit-Taste. Wenn Sie nicht abbrechen, ist das
Preset im gewahlten Speicherort gespeichert.

Die Presets enthalten alle Filter, Dynamik, Gain-Einstellungen usw., mit anderen Worten, alles, was
einstellbar ist. Aber Presets enthalten nicht den Namen des Gerats, Netzwerkkonfiguration, automatische
Standby-Verzdgerung, Zugriffsrechte und Kennworter.

3.4.3.Passwort Level

Der DSM-26/-48LAN hat die Mdglichkeit, Sperren fur bestimmte Bedienelemente auf der Vorderseite des
Gerates einzurichten. Dies soll verhindern, dass unbefugte Personen das Gerat manipulieren.

Um das Gerat zu sperren, wahlen Sie "Locked" durch Drehen des Drehreglers und driicken Sie zur
Bestatigung. Das System fordert Sie auf, ein Kennwort einzugeben. Wahlen Sie ein Zeichen mit dem Cursor
durch Drehen des Drehreglers aus. Durch Dricken der Drehreglers wird das Zeichen bestatigt. Bewegen Sie
den Cursor zum nachsten Zeichen, das Sie bearbeiten mochten. Durch Driicken der EXIT/ESC-Taste, wird das
letzte Zeichen geldscht. Sobald das Passwort eingestellt ist, driicken Sie die Menu-Taste und das Gerat ist
gesperrt.

ACHTUNG: Achten Sie darauf, dass das Passwort nicht vergessen oder von Unbefugten benutzt wird!

Wenn das Gerat gesperrt ist und Sie das Passwort vergessen haben, ist es nicht mdglich, ohne den &rtlichen
Kundendienst zu entsperren.
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Um das Gerat zu entsperren, geben Sie das Passwort ein. Das Passwort wird automatisch nach jedem
eingegebenen Zeichen uberprift und das Gerat wird das System-Menu verlassen, wenn das Kennwort
komplett eingegeben und bestatigt wurde.

Das voreingestellte Passwort lautet "Password".

3.4.4 VVersions-Informationen

Durch Driicken des Drehreglers, wechselt die Anzeige zwischen einer Software-Versions-Informationen tber
das Gerat, sowie einigen anderen Parameter wie IP-Adresse, MAC-Adresse etc.
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Instruction Manual for DSM-26LAN / DSM-48LAN

Introduction

Congratulations on the purchase of your DSM-26/-48LAN. IMG Stage Line strives to be the best in high end
digital audio processing.

After you have become familiar with the processor, we encourage you to experiment and find the

most effective and efficient way to run your system by utilizing the powerful processing of the DSM-26/-48LAN.

The DSM-26/-48LAN is a powerful speaker management system with 2/4 analog inputs, 2 AES/EBU inputs,
6/8 outputs, 10 PEQ bands per input and output and a frequency range up to 40kHz.

The rugged analog input stage accepts input voltages of up to +23dBu thus matching any source on the
market today, with an excellent dynamic range of 118dB. Using a 64-bit digital processing and some of the
best converters available on the market today, the DSM-26/-48LAN offers sound quality which can compete
with whatever your reference unit of choice is.

This User Manual describes how to operate the DSM-26/-48LAN's settings via the front panel controls.
Alternatively, the DSM-26/-48L AN can be configured completely via a remote connection to a PC or MAC.
Please refer to the Software User Manual for details on the remote control application.

Controlled via the front panel or via the remote control application, the DSP settings and coefficients are
calculated on-the-fly at the moment of changing the parameters. Frequencies can be set with 1Hz accuracy,
delays with ten microseconds, accuracy, and gains with 0.01dB accuracy. When editing values via the front
panel, some values are limited in granularity; e.g. gain is set via 0.25dB steps in this case.

Features:

- 118dB dynamic range (inputs) / 114dB dynamic range (outputs)

- Electronically balanced inputs

- Electronically balanced outputs

- Frequency range 20Hz....40kHz

- Ten parametric filters per input and output

- EQs can be set as Bell, High Shelf, Low Shelf, Notch, Allpass, Band Pass, High Pass, Low Pass
- 1000ms delay per input, 20ms delay per output (DSM-26LAN)

- 2000ms delay per input, 2000ms delay per output (DSM-48LAN)

- Butterworth, Bessel, Linkwitz-Riley filters up to 24dB / oct.

- True RMS Compressor

- Zero Attack Peak Limiter

- Latency 660 microseconds

- Full configuration and real-time monitoring via PC or MAC (USB and Ethernet interface)
- Integrated 16-character LCD display

- 80 Presets

- 64 bits multi-mode digital processing
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Safety Instructions

WARNING, FOR YOUR PROTECTION READ THE FOLLOWING: The apparatus shall not be exposed to
dripping or splashing liquid and no object filled with liquid, such as vases, shall be placed on the apparatus.
CLEAN ONLY WITH A DRY CLOTH. DO NOT BLOCK ANY VENTILATION OPENINGS. INSTALL IN
ACCORDANCE WITH THE MANUFACTURER’S INSTRUCTIONS. DO NOT INSTALL NEAR ANY

HEAT SOURCES SUCH AS RADIATORS, HEAT REGISTERS, STOVES, OR OTHER APPARATUS
(INCLUDING AMPLIFIERS) THAT PRODUCE HEAT. ONLY USE ATTACHMENTS/ACCESSORIES
SPECIFIED BY THE MANUFACTURER. UNPLUG THIS APPARATUS DURING LIGHTNING STORMS OR
WHEN UNUSED FOR LONG PERIODS OF TIME. Do not defeat the safety purpose of the polarized or
grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug
has two blades and a third grounding prong. The wide blade or third prong is provided for your safety. If the
provided plug does not fit your outlet, consult an electrician for replacement of the obsolete outlet. Protect the
power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point
where they exit from the apparatus. Use only with the cart stand, tripod bracket, or table specified by the
manufacture, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus
combination to avoid injury from tip-over. Refer all servicing to qualified service personnel. Servicing is
required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged,
liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or
moisture, does not operate normally, or has been dropped. POWER ON/OFF SWITCH: If the equipment has
a Power switch, the Power switch used in this piece of equipment DOES NOT break the connection from the
mains. MAINS DISCONNECT: The plug shall remain readily operable. For rack mount or installation where
plug is not accessible, an all-pole mains switch with a contact separation of at least 3 mm in each pole shall
be incorporated into the electrical installation of the rack or building. FOR PRODUCTS EQUIPPED WITH
EXTERNALLY ACCESSIBLE FUSE RECEPTACLE: Replace fuse with same type and rating only.
MULTIPLE-INPUT VOLTAGE: This equipment may require the use of a different line cord, attachment plug,
or both, depending on the available power source at installation. Connect this equipment only to the power
source indicated on the equipment rear panel. To reduce the risk of fire or electric shock, refer servicing to
qualified service personnel or equivalent. If connected to 240V supply, a suitable CSA/UL certified power
cord shall be used for this supply. This equipment is intended for rack mount use only.

WARNING: THIS APPLIANCE SHALL BE CONNECTED TO A MAINS SOCKET OUTLET WITH A
PROTECTIVE EARTHING CONNECTION. The cores in the mains lead are colored in accordance with the
following code: GREEN and YELLOW - Earth BLUE - Neutral BROWN. Live As colors of the cores in the
mains lead of this appliance may not correspond with the colored markings identifying the terminals in your
plug, proceed as follows: The core which is colored green and yellow must be connected to the terminal in
the plug marked with the letter E, or with the earth symbol, or colored green, or green and yellow. The core
which is colored blue must be connected to the terminal marked N or colored black. The core which is
colored brown must be connected to the terminal marked L or colored red. This equipment may require the
use of a different line cord, attachment plug, or both, depending on the available power source at installation.
If the attachment plug needs to be changed, refer servicing to qualified service personnel who should refer to
the table below. The green/yellow wire shall be connected directly to the processor’s chassis.

WARNING: If the ground is defeated, certain fault conditions in the processor or in the system to which it is
connected can result in full line voltage between chassis and earth ground. Severe injury or death can then
result if the chassis and earth ground are touched simultaneously.

There are dangerous voltages present within the processor.

It is necessary for the user to refer to the instruction manual.

There are no user serviceable parts inside the processor.

Do not open the processor. Do not attempt to service the processor yourself. Refer all servicing to qualified
personnel. Opening the chassis for any reason will void the manufacturer’s warranty. Do not get the
processor wet. If liquid is spilled on the processor, shut it off immediately and take it to a dealer for service.
Disconnect the processor during storms to prevent damage.
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1.0verview of Connectors and Controls

In addition to the available features described in this manual, you also have the option of controlling the DSM
with a PC or MAC from a remote location over your network or via a USB cable. Please refer to the
Software Manual for details.

1.1.Front Panel

1.1.1.USB Connector

The USB connector is used to connect the DSM-26/-48LAN to a PC or MAC. It can then be configured
and controlled in real time with the freely available PC and MAC configuration program. With this program you
can also update your DSP to the latest firmware. Please check our website regularly for updates.

1.1.2.Input VU Meters

There are four independent input meters available. The LEDs indicate: Signal (-48dBu), -6dBu, Limit and
Clip. The indication refers to the absolute input level, multiplied with the input gain. The Limit LED lights when
any gain reduction is taking place in that channel. The CLIP LED lights when the input level reaches +22dBu.

1.1.3.Function Buttons

The function buttons allow direct access to all editing and navigating functions. See section three for a
detailed description on the functions of each of these buttons.

1.1.4.Rotary Encoder

The rotary encoder is used to scroll through the menu items by pushing it, and to adjust values by rotating it.
When values are changed, the DSP is updated in real-time.

1.1.5.0utput VU Meters

There are six independent output VU meters available. The LEDs indicate: Signal (-48dBu), -6dBu, Limit and
Clip. The indication refers to the output level w.r.t. the threshold of the output peak limiter. The Limit LED
lights when any gain reduction is taking place in that channel. The CLIP LED lights when more than 12dB of
gain reduction is taking place.

1.1.6.0Output Mute Buttons

The six output mute buttons are used for independently muting each output.
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1.2.Rear Panel

1.2.1.Power Connector

The DSM-26/-48LAN has an internal power supply that will accept voltages ranging from 200V - 240V and
frequencies from 50Hz-60Hz. An IEC cord is included.

1.2.2.Power Switch

The Power Switch turns the DSM-26/-48LAN on and off. Note: we recommend that power amplifiers connected
to the product, should be powered down prior to cycling the power of this product.

1.2.3.Ethernet Connector

This RJ-45 connector is used to connect your product to a network. It can then be configured and controlled
in real time with the freely available PC and MAC configuration program. With this program you can also
update your DSP to the latest firmware. Please check our website regularly for updates.

1.2.4.Analog inputs

The analog input section of the DSM-26/-48LAN offers 2/4 electronically balanced XLR connectors.
The input level is +23dBu max (11V eff.).

1.2.5.Analog Outputs

The output section of the DSM-26/-48LAN offers 6/8 electronically balanced XLR connectors. The output level
is +12dBu max (4V eff.).

1.2.6.AES/EBU Inputs

The digital input of the DSM-26/-48LAN offers two input channels (stereo) on an balanced XLR connector.
The processor will accept AES/EBU signals (balanced) and S/PDIF signals (unbalanced) of 16 to 24 bit
resolution and 44.1, 48, 88.2, or 96kHz sample frequency.
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2.Getting Started

2.1.Quick Start

For those of you that wish to jump right in, the following information has been provided to act as a quick start
guide for optimizing performance of your processor.

2.2.Connections

2.2.1.Signal Connections

When setting up your processor, make connections as follows:

- Always make connections prior to applying power to the processor.

- Connect the output(s) from the sending device (mixer) to the CH1 XLR input connector (mono) or both, CH1
and CH2 XLR input connectors (stereo).

- Make output connections from the output XLR connector(s) to the input connector(s) of the selected power
amplifier(s).

Always make sure that your power amps are the last item turned on and the first turned off.

Once all of the connections have been made, and the processor is powered up, you can navigate through the
entire signal path of your processor from the front panel. The display provides you with a clear and concise
overview of each aspect of the signal path from the input (left side of display) to the output section (right side
of display).

2.2.2.Remote Monitoring and Control

For the quickest and easiest results we recommend to install and use the freely available PC or MAC
configuration software. It provides a complete and comprehensive tool to make your loudspeaker
configuration settings, and to manage your presets.

When connecting the unit via USB, make sure to connect it directly to your computer or to use a USB hub
that supports USB1.0. If you have problems with the USB connection, please refer to the Installation Guide
for details on how to install the proper driver.

When connecting the unit via an Ethernet network, you have several options. The PC/MAC application has
an auto-discovery tool that will automatically connect to any unit found on the network.

Please refer to the Software Manual available on our website for details on the control software.

2.2.2.1.Standard DHCP Network

For the easiest connection, use a standard Ethernet Router, plug in the unit and your computer, and the
connection should be made automatically. Standard routers have a DHCP server built in and enabled. A
DHCP server assigns a network address to your computer and to the DSM-26/-48LAN,

allowing them to connect automatically.

2.2.2.2.Connection without DHCP server

Alternatively, you can use a direct (cross) cable or a simple Ethernet Switch to connect the unit to your PC or
MAC. Please note that in this case, especially Windows computers may take up to several minutes to assign
themselves a network address (indicated by the text: "This connection has limited or no connectivity"). The
computer and the DSM-26/-48LAN both will assign themselves a network address in the ZeroConfig range
(169.254.0.0 - 169.254.255.255), and the DSM-26/-48LAN will be discovered automatically by the PC/MAC
application. To facilitate connections without DHCP router, it may be convenient to set your computer to a
fixed IP address. If you do this, please choose any address in the ZeroConfig range, and set the subnet mask
to 255.255.0.0.
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2.2.2.3.Fixed IP address

It is also possible to set a fixed IP address and subnet mask for the DSM-26/-48LAN.

WARNING: If you set a wrong address (in a different range than your computer), you may not be able to
connect anymore.

Itis STRONGLY RECOMMENDED to consult a system administrator before making such settings.

2.2.2.4 Firewall

After starting the software application for the first time, your computer may ask you to allow or block the
application access to the network. Please make sure to allow this; if there is a firewall between the application
and the DSM-26/-48LAN, the application will not find the DSM-26/-48LAN.

2.3.System Setup and Gain Structure

This product offers a wide range of tools for sound system design and setup. These tools can make your
system more efficient and better sounding, but to get the best possible sound it is important to use these tools
properly.

The following section explains how to maximize system gain and how to use the limiters to protect your
amplifiers from clipping. In traditional system design, the output of your console would be routed to a system
EQ, a compressor, and a crossover with output level control. From the crossover, there may be additional
filters that are employed to improve the response of your speakers. There may also be limiters set up to keep
your amplifiers from going into clipping and protect your speakers from the hazards of a clipped signal. Your
amplifiers play a vital role in system setup, because they are last item in the chain before your speakers and
offer the greatest amount of gain (that is their job after all). If your limiters and amplifiers are incorrectly setup
you will not be using your system to its fullest potential and could be harming your speakers.

To ensure an optimal gain structure:

Play a signal at the nominal level from your mixing desk, and set the input gain of your processor to 0.

Set the crossovers that you want to use, while keeping the output gains also at 0.

With DISCONNECTED loudspeakers, turn up the volume of the power amplifiers entirely clockwise (full
volume).

Now reduce the output gain and / or the output limiter setting to get the desired gain, so that the amplifier is
just clipping and the built-in limiters of your processor are just limiting. If the amplifier does not have a built-in
clip limiter, set your processor's limiter so that the amplifier does not clip.

Now turn down the volume of the power amplifiers, connect your speakers, and slowly increase the volume
while checking the sound.

If all is well, there should be distortion-free sound, and the limiter LEDs are flashing or off, but not
continuously on. If they are continuously on, reduce the output gain of your processor.

If you can not reach enough signal level, increase the processor's input gain or turn up the level from your
mixing desk.
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3.Setup And Operation

Before plugging the processor in, always make sure that the power supply matches the product specification
voltage. Install this device on a flat, stable surface, not bend or curved. Do not supply power before all
components of the system are set up and connected properly. Make sure to power-up your device before
your power amplifiers are switched on in order to avoid transients, which could damage your speakers or
annoy your audience.

3.1.System Check

After connecting all cables, you should mute all outputs first or turn the gain/level setting on your amplifiers to
minimum. Activate the HF-outputs first. In case of wrong cabling, High Frequency (HF) audio signals will
come out of bass-speakers that cannot be harmed this way. Vice versa, the Low Frequency (LF) audio
signals would destroy your HF-speakers. It is advisable to install a large capacitor in series with HF drivers
(47 - 100 uF). That way, drivers are somewhat protected against accidental instrumentation errors.

3.2.Input Setup

Press the Channel Up or Down button to select the input channel you wish to edit. Make the first settings with
the output turned low or muted.
To toggle through the different items, press the Item Up or ltem Down buttons.

3.2.1.Gain

Adjust the gain by dialing the rotary encoder. The gain is adjusted in steps of 0.25dB. Smaller steps (0.01dB)
can be set via the PC or MAC interface.

3.2.2.Input Selection
Select the source (Analog or AES/EBU) by rotating the encoder.

3.2.3.Delay

Set the delay time by turning the encoder. Select the displayed unit (ms or s, mm or m, feet, inches, or mils)
by pushing the encoder.

3.2.4.Low Pass Filter

Adjust the Low Pass Filter frequency by turning the rotary encoder. You can switch the low pass filter off by
turning the rotary encoder up (clockwise) until the frequency passes 20kHz.

Press the rotary encoder to change the filter type. Select the type by turning the rotary encoder. You can
choose from: Butterworth 6dB, Bessel 6dB, Butterworth 12dB, Bessel 12dB, Linkwitz Riley12dB, Butterworth
18dB, Bessel 18dB, Butterworth 24dB and Bessel 24dB. Higher order filters may be set by adding filter
sections in the PEQ blocks (see below).
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3.2.5.High Pass Filter

Adjust the high pass frequency by dialing the rotary encoder. You can switch the high pass filter off by dialing
the rotary encoder down (counterclockwise) until the frequency passes 20Hz.

Press the rotary encoder to change the filter type. Select the type by turning the rotary encoder. You can
choose from: Butterworth 6dB, Bessel 6dB, Butterworth 12dB, Bessel 12dB, Linkwitz Riley12dB, Butterworth
18dB, Bessel 18dB, Butterworth 24dB and Bessel 24dB. Higher order filters may be set by adding filter
sections in the PEQ blocks (see below).

3.2.6.Parametric Equalizer (PEQ)

There are ten bands of parametric equalization. Each band can be adjusted freely over the complete
frequency range of 20Hz to 20kHz. Adjust the frequency by dialing the rotary encoder.

Press the rotary encoder to select the parameters. The available parameters are: Frequency (20Hz to
20kHz), Gain (-12dB to +12dB), Q (0.2 to 25), Enabled (On or Off), Type (Bell, High Shelf, Low Shelf, Notch,
All Pass, Band Pass, High Pass, Low Pass). For the Shelving filters, the Q value sets the steepness of the
filter in dB/Oct.

3.2.7.Compressor

The compressor is a true RMS compressor. Turn the rotary encoder to set the threshold. Press the rotary
encoder to select the parameters. The available parameters are: Threshold, Attack, Hold, Release, Ratio,
and Makeup Gain.

3.2.8.Limiter

The limiter is a zero-attack peak limiter. Only the threshold and release can be set. Press the rotary encoder
to select the parameters. The release value is displayed in dB per second.

3.2.9.Channel Link

By linking 2 channels, the settings are guaranteed to be identical for both channels, except for mixer and
mute. Turn the encoder to set the Channel Link on or off.

[
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3.3.0utput Setup

Press the Channel Up or Down button to select the output channel you wish to edit. Make the first settings
with the output turned low or muted.
To toggle through the different items, press the Item Up or Item Down buttons.

3.3.1.Gain

Adjust the gain by dialing the rotary encoder. The gain is adjusted in steps of 0.25dB. Smaller steps (0.01dB)
can be set via the PC or MAC interface.

3.3.2.Mixer

Turn the rotary encoder to mix the signal from the selected input to the selected output. Push the rotary
encoder to select the input. Attention: The mixer is only available while the outputs are not linked by Channel
Link. If the channels are linked, the mixer will be skipped.

3.3.3.Delay

Set the delay time by turning the encoder. Select the displayed unit (ms or s, mm or m, feet, inches, or mils)
by pushing the encoder.

3.3.4.Low Pass Filter

Adjust the Low Pass Filter frequency by turning the rotary encoder. You can switch the low pass filter off by
turning the rotary encoder up (clockwise) until the frequency passes 20kHz.

Press the rotary encoder to change the filter type. Select the type by turning the rotary encoder. You can
choose from: Butterworth 6dB, Bessel 6dB, Butterworth 12dB, Bessel 12dB, Linkwitz Riley12dB, Butterworth
18dB, Bessel 18dB, Butterworth 24dB and Bessel 24dB. Higher order filters may be set by adding filter
sections in the PEQ blocks (see below).

3.3.5.High Pass Filter

Adjust the high pass frequency by dialing the rotary encoder. You can switch the high pass filter off by dialing
the rotary encoder down (counterclockwise) until the frequency passes 20Hz.

Press the rotary encoder to change the filter type. Select the type by turning the rotary encoder. You can
choose from: Butterworth 6dB, Bessel 6dB, Butterworth 12dB, Bessel 12dB, Linkwitz Riley12dB, Butterworth
18dB, Bessel 18dB, Butterworth 24dB and Bessel 24dB. Higher order filters may be set by adding filter
sections in the PEQ blocks (see below).
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3.3.6.Parametric Equalizer (PEQ)

There are ten bands of parametric equalization. Each band can be adjusted freely over the complete
frequency range of 20Hz to 20kHz. Adjust the frequency by dialing the rotary encoder.

Press the rotary encoder to select the parameters. The available parameters are: Frequency (20Hz to
20kHz), Gain (-12dB to +12dB), Q (0.2 to 25), Enabled (On or Off), Type (Bell, High Shelf, Low Shelf, Notch,
All Pass, Band Pass, High Pass, Low Pass). For the Shelving filters, the Q value sets the steepness of the
filter in dB/Oct.

3.3.7.Compressor

The compressor is a true RMS compressor. Turn the rotary encoder to set the threshold. Press the rotary
encoder to select the parameters. The available parameters are: Threshold, Attack, Hold, Release, Ratio,
and Makeup Gain.

3.3.8.Limiter

The limiter is a zero-attack peak limiter. Only the threshold and release can be set. Press the rotary encoder
to select the parameters. The release value is displayed in dB per second.

3.3.9.Phase Inversion
Turn the rotary encoder to switch phase inversion on or off.

3.3.10.Channel Link

By linking 2 channels, the settings are guaranteed to be identical for both channels, except for mixer and
mute. Turn the encoder to set the Channel Link on or off.
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3.4.System Menu

Push the Menu button to enter the system menu. Push the Menu button again to toggle through the menu
items. The available menu items are:

3.4.1.Load Preset

Turn the rotary encoder to select the preset you wish to load. Push the rotary encoder to select it, then turn it
again to select "YES" and confirm again by pushing the rotary encoder knob. The preset is loaded and all
settings are applied immediately. All settings that were in the unit prior to loading the preset will be erased.
This action can not be undone.

The presets contain all filter, dynamics, gain settings etc; in other words, everything that makes out a
loudspeaker configuration. Presets do NOT contain the name of the unit, network configuration, automatic
standby delay, user access rights and passwords.

3.4.2.Save Preset

Turn the rotary encoder to select the location of the preset. If that location is not empty, the preset in that
location will be overwritten. This action can not be undone.

The system will ask you to give a name to the preset name. Select a character in the cursor position by
turning the rotary encoder; pushing the rotary encoder confirms the character selected and moves the cursor
to the next character to edit. Pushing the exit/ESC button erases the last confirmed character. Once the
name is set up, push the menu button again. If you want to continue storing the preset, select Yes by turning
the rotary encoder and confirm by pushing it. To cancel, push the exit button. Now your preset is saved in
the selected location.

The presets contain all filter, dynamics, gain settings etc; in other words, everything that makes out a
loudspeaker configuration. Presets do NOT contain the name of the unit, network configuration, automatic
standby delay, user access rights and passwords.

3.4.3.Access Level

The DSM-26/-48LAN has the option of locking away the front panel controls to avoid tampering of settings by
unauthorized persons. To lock the unit, select "Locked" by turning the rotary encoder, and push it to confirm.
The system will ask you to enter a password. Select a character in the cursor position by turning the rotary
encoder; pushing the rotary encoder confirms the character selected and moves the cursor to the next
character to edit. Pushing the exit/ESC button erases the last confirmed character. Once the password is set
up, push the menu button again and the unit will be locked.

ATTENTION: Make sure to remember the password! When the unit is locked and you forgot the password, it
is not possible to unlock it without contacting your local service representative.

To unlock the unit select "Unlocked" and enter the password. The password is automatically checked after
each entered character, and the unit will exit the system menu when the password is confirmed.

The default password is "Password".

3.4.4 Version Information

By pushing the rotary encoder, the display toggles through some version information about the unit, as well
as some parameters like IP address, MAC address etc.
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